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In the last five years, the growth of the Indian telecommunications sector has outpaced the overall economic 
growth. This sector is poised for strong growth of about 15 percent in the short term during 2013–17, driven by 
growth in organised retail, technological advancements, changing consumer preferences and government support. 
With over 1 billion subscribers, India is the second largest telecom market in the world.
The sector employs over 2.08 million employees as of 2013, and is slated to employ more than 4.16 million 
employees by 2022. This implies additional creation of 2.1 million jobs in the nine-year period. 
This Participant Handbook is designed to impart theoretical and practical skill training to students for becoming 
a Customer Care Executive (Call Centre). Customer Care Executive (Call Centre) in the Telecom industry is also 
known as Customer Service Representative / Customer Service Associate / Customer Service Advisor / Customer 
Relationship Officers / Call Centre Executive.
Individuals at this job provide customer service support to an organization by interacting with their customers over 
the phone. They also handle, follow and resolve customer’s queries, requests and complaints in a timely manner. 
This Trainee Manual is based on Customer Care Executive (Call Centre) Qualification Pack (TEL/Q0100) & includes 
the following National Occupational Standards (NOSs): 
1. Attend/Make customer calls - TEL/N0100
2. Resolving customer query, request, complaint - TEL/N0101
3. Develop customer relationship - TEL/N0102
4. Report and review - TEL/N0103
5. Proactive selling - TEL/N0104
The Key Learning Outcomes and the skills gained by the participant are defined in their respective units.
Post this training, the participant will be able to make & attend customer calls, provide resolution to customer 
queries & complaints, and hence will be able to develop customer relationship.
We hope that this Participant Manual will provide a sound learning support to our young friends to build an 
attractive career in the telecom industry.
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At the end of this module, you will be able to:
1.  State the objectives of the program 
2.  Describe the Telecom industry in India
3.  Understand the concept of a call centre and help desk
4.  Discuss the hierarchy in a call centre and the career progression of a Customer Care Executive (CCE) in a call 

centre

5.  Understand the roles and responsibilities of a CCE 
6.  Explain the concept of customer service and its importance in the role of a CCE

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..
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This program will facilitate an overview of:
1. Telecom Call Centre

2. Behavioural, professional and technical skills required for performing your job effectively
3. How to attend/make voice calls to the customers
4. Handling, resolving and following-up for resolutions to customer queries in a timely manner
5. Developing a relationship with customers by resolving their concerns and building a rapport
6. Monitoring and managing self-performance through a report and review process

1.1.1 Importance of the Program

UNIT 1.1: Introduction

At the end of this unit, you will be able to: 
1. Know the agenda and importance of the program
2. Get an overview of the Telecom industry in india
3. Understand the regulatory framework
4. Know the major players and their market share

Unit Objectives

Telecom Industry at a Glance
 ● In todays world the telecom services are the most important tool for socio economic development. 
 ● It is one of the prime support services needed for rapid growth and modernization of various sectors of the 

economy.
Telecom in India

 ● In recent years, the Indian telecom industry has witnessed phenomenal growth.
 ● A conducive business environment, favourable demographic outlook, and the political stability enjoyed by the 

country have contributed to the growth of the industry.
 ● India achieved the distinction of being among the world’s lowest call rates, the fastest sale of mobile phones, the 

cheapest mobile handset, and most affordable colour phone.
 ● The Indian telecommunication sector has undergone significant policy reforms, beginning with the of National 

Telecom Policy (NTP) 1994 which was subsequently re-emphasized and carried forward under NTP 1999.

1.1.2 An Overview of the Telecom Industry

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..
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1.1.3 Regulatory Authorities in the Telecom Industry
TRAI - Telephone Regulatory Authority of India 

 ● Provide fair and transparent policies to service providers, so that there is a level playing field for the competition.
 ● Provide direction on tariff, interconnection and quality of service to all the service providers.
 ● To ensure that interests of the consumers are protected via fair trading.

COAI - Cellular Operators Association of India
 ● Facilitates the establishment of a world class cellular infrastructure and delivers the benefits of affordable mobile 

telephony services to the people of India.

TDSAT - Telecom Disputes Settlement and Appellate Tribunal
 ● It adjudicates any dispute with a view to protect the interests of service providers and customers of the telecom 

sector.
DoT - Department of Telecommunications

 ● It formulates developmental policies for the accelerated growth of telecommunication services.
TRAI Regulation on Call Centre
1. 121 - General information number - Chargeable Call
2. 198 - Consumer care number - Toll Free Number
3. Service Request - request made pertaining to the account for:

 ● Change in plan

 ● Activation/deactivation of VAS/ supplementary service/ special pack
 ● Activation of service provided by the operator
 ● Shifting/disconnection of service/billing details

1.1.4 Major Players in Telecom Industry

S.No. Name of Company Year of Establishment Revenue Market Share as of 
2015

1 Bharti Airtel 1985 30.44 %
2 Vodafone Essar 2007 23.19%
3 Idea Cellular 1995 18.19 %
4 Reliance Communications 1999 6.07%
5 Tata Teleservices 1996 7.41 %
6 BSNL/MTNL 2000 6.12/3.04%
7 Aircel 1999 7 %
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Fig. 1.1.1 Logos of major Indian telecom companies

Answer the following questions:
1. Which telecom company has the highest market share?

_________________________________________________________________________________________

_________________________________________________________________________________________

2. Which telecom company has the lowest market share among the top 7 companies?
_________________________________________________________________________________________

_________________________________________________________________________________________

3. Name top 5 telecom companies in India
a) _____________________________________________

b) _____________________________________________

c) _____________________________________________

d) _____________________________________________

e) _____________________________________________

4. Fill in the blank with the correct answer:
       India has achieved the distinction of world’s _________________ call rates. (lowest/highest)

5. Write down the full form of the following Abbreviations:
f) TRAI - __________________________________________________________________

g) DoT - __________________________________________________________________

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..
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Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

h) COAI -__________________________________________________________________

i) TDSAT -__________________________________________________________________

6. What is the current scenario in the Indian Telecom industry?

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..
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1.2.1 Job Role of a CCE-Call Centre

1.2.2 Departments in Telecom Call Centre

A customer care executive works as a bridging force between the customer and the organisation. He tries to meet the 
needs of the customer within the ambit of the management's policies and guidelines.

 ● To attend/make calls to the customer
 ● To provide information regarding products and services to the customer
 ● To handle and resolve customer’s complaints/requests
 ● To capture/take notes of customer interaction in the Customer Relationship Management (CRM) tool/software.
 ● To monitor and manage key performance through reports
 ● To develop customer relationship

 ● Operation
 ● Administration & Facilities
 ● Human Resources
 ● Finance
 ● Training & Quality
 ● Information Technology (IT)
 ● Process Improvements/Excellence

UNIT 1.2: Department and Jobs in a Telecom Call Centre

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the role of a CCE and the skills required for the same
2. Understand the departments and jobs in a Telecom Call Centre
3. Understand the hierarchy & career path of a CCE in the organization
4. Understand the concept of a Call Centre
5. Understand the function of a Help Desk

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..
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1.2.3 Jobs Hierarchy in a Telecom Call Centre (Operation Dept.)

CCE

Sr. CCE

Floor Supervisor

Team Leader

Manager

Sr. Manager

1.2.4 Call Centre

1.2.5 Help Desk

A company direct contact centre that handles services such as customer support, emergency response, telephone 
answering service, and outbound telemarketing is known as a call centre. A call centre handles a considerable volume 
of calls at the same time; screens calls and forward calls to someone qualified to handle them, and eventually logs 
them. 

In a business enterprise, a help desk is a place where a customer can call to get help with a query, request or complaint. 
Generally, a help desk refers to an expert (CCE) with apt knowledge and computer applications, which help him answer 
the queries that come in.

Fig. 1.2.1 Career ladder of a CCE

1.2.6 Customer Care Executive (CCE)
Customer Care Executives use their skills and experience to ensure that a company delivers the highest standards of 
service to customers and on the basis of it, create a positive perception of themselves as well as the company. A CCE is 
the most critical contact point for the customers to build a long lasting relation or loss of relation.
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A CCE must follow the CARING approach as given below:

1. Which of these form a part of the role of a CCE?

a) Developing good customer relations

b) Handling customer complaints

c) Good product knowledge

d) Resolve customer queries

e) Technical knowledge

f) Follow up with the customers

2. Write down few skills, which according to you are very crucial in a CCE’s job. 

___________________________________________________________________________________________

___________________________________________________________________________________________

3. What are the three things that are very important to be able to work in the telecom Call Centre?

a) ___________________________________________

b) ___________________________________________

c) ___________________________________________

4. An ______________________ is one in which Call Centre agents make calls to customers for a business or client.
(Inbound Call Centre/Outbound Call Centre)

5. The ______________________ provides customer support, online help, bookings, placing orders, resolving issues/
queries etc. (Inbound Call Centre/Outbound Call Centre)

6. An _______________________ do telemarketing, debt collection, sales, fund raising and other work that requires 
proactive contact with customers. (Inbound Call Centre/Outbound Call Centre)

7. An _______________________ is one that exclusively or predominately handles inbound calls. (Inbound Call 
Centre/Outbound Call Centre)

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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C- Courteous
A- Alive and Energetic
R- Responsive
I- Informed
N- Never says ‘NO’
G- Guides Right
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UNIT 1.3: Help Desk and Customer Care Services

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the concept of customer service and its importance

1.3.1 Customer

1.3.2 Customer Service

 ● Customer is the king.
 ● Customers can either be Consumer customers or Business customers.
 ● Increasing the customer base is the ultimate goal of every business since; “more the customers, more is likely 

to be the business profitability.”

Excellent customer service is the ability of an organization to exceed the customer’s expectations each time every 
time. It’s all about attitude and skills. 

 ● Attend to customers (Greet, introduce products, understand needs, give information asked for like guarantee, 
features, advantages, discounts, etc.).

 ● Give product choices and information (offer different products available, give information like guarantee, 
comparative features, advantages, discounts, etc.).

 ● Offer the best solutions to the customer (help to make the best choice keeping all interests in mind to ensure 
that a sale can be closed as well as ensure that the need of the customer is fulfilled).

 ● Handle customer queries, requests or complaints (such as renewal of subscription, queries on new plans, 
complaints about network troubles or overbilling, troubleshoot and resolve customer’s product/service 
related issues).

 ● Clear doubts or queries, if any about price, quality, features, and handle objections).

1.3.3 Importance of Customer Service
 ● The objective of any organization is to fulfill the needs of a customer, hence customer satisfaction  plays a vital 

role in any business.
 ● Customers help in meeting business objectives.
 ● Customers are a source of revenue generation for the business.

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1.3.4 Characteristics of Excellent Customer Service:

Communication Supplying needed information in a clear/convenient way

Consistency Service provided should be the same everyday

Dependability Doing, whatever is committed

Friendliness Positive and supportive

Fairness Trying honestly to do what is in the customer’s best interest while keeping in 
mind the interest of the company

Fairness Occupation is a set of job roles under which role-holders perform similar/related 
set of functions in an industry

Flexibility Willing to adjust services according to customer’s need

Responsiveness Moving quickly and effectively to meet customer’s needs and requests

Respectfulness Not wasting the customer’s time and listening without interruption

Sincerity Being honestly and truly concerned about serving customer’s needs

Speciality Meeting specialised needs

Sensitivity Treating customers as important by being alert and caring

Solving Problems Taking action quickly and decisively

1.3.5 Building Rapport with Customers

As a customer service representative you are responsible for helping the customer out as best as you can. Helping 
them out can mean a lot of things. Highlight certain features and facts to them as considered necessary, direct them 
to the right department. Either way you have to help the customer as best as you can.
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Exercise
1. Mention rules that need to be followed for great customer service.

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

2. Customer Service – is it important to you? Think about a time when you received excellent customer service. What 
made it so excellent? How did the individual or company make you feel special?

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

3. List all the things you can remember about the experience below. Be prepared to share your experience with a 
partner.

What makes a service, a good experience to you?

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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     Dos       Don'ts

 ● Use Customer’s name
 ● Be polite

 ● Be honest

 ● Smile

 ● Give your full attention
 ● Take ownership

 ● Follow up
 ● Enjoy what you do

 ● Take it personally
 ● Use negative words
 ● Be sarcastic
 ● Make excuses

 ● Lie
 ● Pass the buck
 ● Get into confrontation
 ● Tighten the face

1.3.6 Establish Good Rapport
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Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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4. Now think about a time when you received appalling customer service. What made it so bad? Again list your 
recollections below and be prepared to share your experience with a partner.

What makes a service, a bad experience to you?

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

5. Did you complain about the poor customer service?

Yes    No

4. Did you acknowledge the excellent customer service?

Yes    No
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At the end of this module, you will be able to:
1.  Identify the key people involved in the process of being a CCE
2.  Explain the various mobile and data technologies
3.  Know and understand the various product and service offerings in the telecom sector
4.  Outline the documentation process and documents needed for mobile customers
5.  Explain the key concepts related to call centres
6.  State the importance of workplace ergonomics and respect at workplace
7.  Express the importance of data confidentiality in the telecom industry

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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2.1.1 Mobile Technologies
There are two types of technologies in our business:

1. Mobile Technologies

a) GSM

b) CDMA

2. Data Technologies

a) 1G

b) 2G

c) 3G

d) 4G

GSM

 ● GSM full form is Global System for Mobile Communications

 ● GSM operates on 900 MHz, 1800 MHz and 1900 MHz frequencies 

 ● GSM is a chip dependent technology

 ● GSM handsets have to be loaded with a SIM card 

GSM Structural Design

It has four main domains:

 ● Base-Station Subsystem (BSS)

 ● Mobile Station (MS)

 ● Operation and Support Subsystem (OSS)

 ● Network and Switching Subsystem (NSS)

 ● Call Routing Process

UNIT 2.1: Mobile Technologies

Unit Objectives
At the end of this unit, you will be able to:
1. Know about the various Mobile and Data technologies

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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GSM System Components

Mobile station is a combination of mobile equipment and SIM card.

The Base Station Subsystem helps in communicating with the mobiles on a network. It consists of two elements: Base 
Station Subsystem (BTS), Base Station Controller (BSC).

BTS consists of hardware equipment like radio transmitters and receivers. The BTS transmits and receives data and 
voice signal from the handset to the mobile network. 

The BSC forms the next stage in the GSM network. It controls a group of BTSs, and is often co-located with one of 
the BTSs in its group. It manages the radio resources and controls items such as handover within the group of BTSs, 
allocates channels and the like. 

Network Subsystem is considered as the core network and has different elements. NSS provides main control and 
interfacing for the mobile network. Main functions of NSS are call controlling, charging, mobile management, signalling 
and subscriber data handling. Major elements include Mobile Switching Centre (MSC), Visitor Location Registers (VLR), 
Home Location Registers (HLR), Authentication Centre (AUC) and Equipment Identity Register (EIR).

Mobile Switching Centre (MSC) is responsible for controlling calls in the mobile network. It identifies the origin and 
destination of a call, as well as the type of call. MSC acting as a bridge between a mobile network and a fixed network 
is called gateway MSC.

Network Switching Subsystem Home Location Registers (HLR) is a database which has information about the subscriber 
identity numbers, subscriber services and their locations. 

When the user switches on the mobile phone, the phone registers with the network to identify which BTS it is  
communicating with to route the calls appropriately. 

Visitor Location Registers (VLR) is the database which comprises information about subscribers currently being in the 
service area of MSC/VLR. Visitor Location Register is integrated with the MSC and carries out location registrations and 
updates. 

CDMA

CDMA stands for Code Division Multiple Access—in the context of cell phones and mobile networks, people tend to use 
it interchangeably to refer to two different mobile standards: CDMA One or CDMA 2000.

Difference between GSM and CDMA
Main difference between the two technologies is air interface i.e. the interface between your device and the base 
station. The core network side of both the technology is same.

Data Technologies
1. 1G is the first generation cellular network that existed in 1980s. It transferred data (only voice) via an analog wave. 

However, it had the following limitations:

 ● No encryption

 ● Poor sound quality 

 ● Low speed of transfer 

2. 2G is the second generation technology which introduced the concept of digital modulation which meant converting 
voice (only) into digital code (in your phone) and analog signals. Being digital helped to overcome some of the 
limitations of 1G as it omitted the radio power from handsets thereby making life healthier and it had enhanced 
privacy too.
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1. State True or False:

a) MSC is the heart of GSM network.

b) Mobile station is a combination of mobile equipment and SIM card.

c) GSM is not a chip dependent technology.

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

3. 3G is the current generation of Mobile Telecommunication Standards. 3G allows simultaneous use of speech and 
data services. It offers data rates of up to 2 Mbps. 3G includes services like Video Calls, Mobile TV, Mobile Internet 
and Downloading. There are bunch of technologies which fall under 3G like WCDMA, EV-DO, HSPA and others.

4. 4G is the latest generation of mobile data connectivity built on the foundations set by 3G. 4G offers a faster and 
more reliable connection. 4G offers features like downloading movies or music, streaming YouTube videos and 
uploading images to Facebook at a much faster speed than 3G. 4G is a quicker and easier technology as compared 
to earlier ones.
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This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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UNIT 2.2: Products and Services

Unit Objectives
At the end of this unit, you will be able to:
1. Know various products and services offered

2.2.1 Prepaid Services
 ● Prepaid service is the Pay-as-you-go service wherein the users buy a recharge balance from the provider as  

 per their requirement.
 ● Users can only use these services up to the available balance amount post which they won’t be able to make  

 outgoing calls.
 ● Roaming, STD, and ISD services are pre-activated in prepaid connections.

2.2.2 Postpaid Services

 ● In postpaid services users first avail the service benefit and then pay for the services.

 ● Service pre-sets a dynamic credit limit of the customer, defined on the basis of customer association, security 
deposit and usage.

 ● For certain services like international roaming or to increase credit limit, customer has to make security deposit.

 ● Based on the bill cycle dates, a bill is generated at the end of each month and the users get a grace period for 
payment of these bills. Once the grace period elapses, the outgoing services are automatically barred. services can 
also be barred if customer exceeds credit limits.

 ● Postpaid services also offer the benefits of value added services like International Direct Dialling, Voice Mail, and 
Message-Mate Packs.

Barring of Outgoing Calls
Barring refers to outgoing service barred by operator. Reasons for outgoing call barring are as given below:

1. Postpaid

 ● Non-payment of bill

 ● Exceeding credit limit

2. Prepaid

 ● Documents not submitted

 ● Documents not clear (e.g. if customer’s photo is not clear in customer application form or does not match 
point of interface)

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

21

Customer Care Executive (Call Centre)Customer Care Executive (Call Centre)

2.2.4 Roaming
Roaming is a general term referring to the extension of connectivity services in a location that is different from the 
home location where the service was registered. 
Roaming ensures that the wireless device is kept connected to the network, without losing the connection.

Prepaid Roaming

1. Both National and International roaming service is pre-activated.

2. No security deposit is required.

3. As per TRAI, in prepaid roaming, services are not available in J&K and North East.

Postpaid Roaming

 ● National Roaming is pre-activated.
 ● For International Roaming, customer gives request for activation with security deposit. Charges and process of 

activation may vary from one service provider to other.
Note:

 ● Charges of special or promo packs (SMS /Calls) are not applicable while roaming.
 ● International roaming requires Tri-Band Handset.

 

2.2.5 Value Added Services

1. Services which are beyond standard voice call services are known as Value Added Services.

2. Mobile Value Added Services can be categorised as –

a) Short Messaging System (SMS) Service

b) Information Service

              News alerts, stock prices, air/rail ticket status, bank account balance/transaction alerts etc.

c) Entertainment Service

              Songs, ringtones, caller ring-back tones (CRBTs), wallpapers, games, jokes etc.

d) M-Commerce Service

              M-Payment, M-Banking etc.

2.2.6 Data Services

1. Multimedia Messaging Service (MMS)

2. General Packet Radio Service (GPRS)

3. Pocket Internet
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2.2.7 Call Management Services

Call Management includes:

 ● Call Waiting

 ● Call Hold

 ● Calling Line Identity Presentation (CLIP) & Calling Line Identity Restriction (CLIR)

 ● Call Divert/Call Forwarding

 ● Call Conference

 ● Call Filter

 ● Call Barring

 ● Mobile Communications International (MCI)

Call Waiting
 ● This service is pre-activated on mobile phone

 ● To activate this service ask the customer to go to the phone menu and activate Call Waiting

Call Hold

 ● This is a facility which is used to keep ongoing call on Hold – something like pause and make a new call or answer 
a call which is waiting. 

 ● This is a free service from the operators who support this feature.

MMS

 ● MMS stands for Multi-Media Messaging Service

 ● Multi-Media Messages allows the users to exchange pictures on the GPRS enabled handsets

GPRS

 ● GPRS stands for General Packet Radio Service

 ● GPRS allows the customers to use internet services both on the mobile as well as on the PC

 ● GPRS allows multiple users to share same air interface resources simultaneously

Pocket Internet

Benefits are:

 ● Portability

 ● High Speed Mobile Broadband Service
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CLIP & CLIR
The “Calling Line Identity Presentation (CLIP)” service enables the customer to see the phone number of the calling 
person.

 ● This service is free in Prepaid.

 ● In Postpaid charges may vary from one service provider to other. 

The “Calling Line Identity Restriction (CLIR)” service enables the customer to hide his number when calling.

 ● When CLIR is activated, instead of customer’s phone number, a message like ‘Restricted number’ or ‘Incoming call’ 
is displayed on the screen/caller ID device of the phone customer’s call. Availability of this facility is governed by 
Government of India regulations. This facility is not granted automatically, and operators reserves the right to grant 
this facility only to certain subscribers, based on fixed criteria.

 ● Charges may vary from one service provider to other.

Call Divert/Call Forwarding
This feature allows the customer to divert an incoming call to a landline or cellular number.
Activation Procedure - Customer can divert his calls through Handset:

 ● Go to Call Divert

 ● Chose the option

 ● Enter the number on which customer you want to divert/forward

Customer can select one option from his phone:

 ● Call Divert on “not reachable” 

 ● Call Divert on “busy“

 ● Call Divert on “all calls” 

 ● Call Divert “if no reply’ 
Charges - Call forwarding is a free service from all the operators except the normal call charges apply when a forwarded 
call is answered.
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Call Conference 
 ● With this service customer can talk with up to 5 different people at a time

 ● Each person to whom the customer makes call, can add up to 5 more participants

 ● Charged as a normal call according to tariff to each individual call

 ● In some circles, this service is not available for Prepaid customers

Call Filter
It is a special service but not provided by all the operators to filter or block calls from certain blacklisted numbers  
without disclosing the actual status of your number to the blacklisted numbers.
Charges - monthly rental charges may vary from one service provider to other.

Call Barring

This is a Network (Operator) supported feature which can be easily activated/deactivated via handset menu (if options 
appear in menu, phone should also support this feature). It is available using the 4 digit default password which is 
set by the network, usually 0000 or 1234, or can also be activated and deactivated via USSD codes provided by the 
operator. 

 ● This feature allows the customer to bar incoming and outgoing calls.

 ● This is a security measure to prevent the possible misuse of cellular phone.

 ● Customer can selectively bar all incoming calls or all outgoing calls as well as outgoing ISD calls. Customer cannot 
selectively bar outgoing STD calls. 

MCI

It helps the customer to know the callers and time of the calls, who try to call him when customer’s phone is switched 
off or phone run out of battery, or out of network coverage.
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2.2.8 MNP (Mobile Number Portability)
Mobile Number Portability is a the facility that which allows a subscriber to continue with the same mobile telephone 
number even when he moves from one Service Provider to another within a licensed service area. The portability 
process involves three parties- (i) the subscriber interested in moving, (ii) the service provider from whom the subscriber 
wants to move and (iii) the Recipient Operator (New Service Provider) to whom the subscriber wants to move.
Porting Procedure
A subscriber who wants to port his mobile number needs to:-

 ● Get in touch with the Recipient Operator (RO) to whom he wants to shift his mobile number. 

 ● Get a Customer Acquisition Form (CAF) & Porting Form from the R.O.
 ● Read all conditions of eligibility, permissible grounds for rejection of porting requests carefully. 
 ● Obtain ‘Unique Porting Code’ (UPC) by sending SMS from the mobile number to be ported. To get UPC, the 

subscriber needs to send an SMS to ‘1900’ with the text ‘PORT’ followed by space followed by the 10 digit mobile 
number to be ported. As per government rules, the UPC so obtained will be valid for 15 days for all service areas 
except J&K, NE & Assam service areas where it will be valid for 30 days.

Note: As pre-paid SMS is not permitted in Jammu & Kashmir the subscriber has to dial ‘1900’ to get a UPC. The operator 
at ‘1900’ will provide the UPC after verifying subscriber number with CLI.

 ● Submit the duly filled Porting Form and CAF along with documentary proof to the Recipient Operator.
 ● A postpaid subscriber should also submit a paid copy of the last bill along with the Porting Form and CAF. 
 ● Obtain new SIM card from the Recipient Operator.

Eligibility for Porting
1. A subscriber holding a mobile number is eligible to make a porting request only after 90 days of the date of 

activation of his mobile connection. If a mobile number is already ported once, the number can again be ported 
only after 90 days from the date of the previous porting. 

2. At the time of porting request, a post-paid subscriber is required to submit an undertaking that he has already paid 
all the dues as per the last bill to the Donor Operator and that he/she would be bound to pay all the dues to the 
Donor Operator till its eventual porting and agrees that in event of non-payment of any such dues to the Donor 
Operator, the ported mobile number will be liable to be disconnected by the Recipient Operator.

3. In the case of a pre-paid subscriber, he needs to give an undertaking that he understands that at the time of porting 
the balance amount of talk time, if any, would lapse.

Grounds for Rejecting Porting Request
Porting request can be rejected under the following conditions:
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Fill in the blanks
1. Prepaid service is the ________________________ service
2. In _______________________ services users first avail the service benefit and then pay for the services
3. Services which are beyond standard voice call services are known _______________________
4. MMS and GPRS are types of _______________________

1. If the outstanding payment is not clear.
2. If it has been made before the expiry of a period of ninety days from the date of activation of a new connection.
3. If change of ownership of the mobile number is under process.
4. If the case related to the mobile number sought to be ported, is sub-judice.
5. If the mobile number sought to be ported has been prohibited by a court of law.
6. If the unique porting code mentioned in the porting request does not match with the unique porting code allocated 

by the Donor Operator for the mobile number sought to be ported or validity of UPC has expired.
7. On the ground of subsisting contractual obligations

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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UNIT 2.3: Documentation

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the documentation process for mobile customers

2.3.1 Documentation Process

Fig. 2.3.1 KYC documents

Fig. 2.3.2 List of documents

Proof of address

Customer's Application Form

Proof of identity

• Water/ Electricity bill
• Telephone (landline or 

post paid mobile bill)
• Election commission 

photo ID card 
• Ration card
• Aadhaar card
• Proof of gas connection
• Passport (not expired)

• Aadhaar card
• Passport
• Election / voter's card
• PAN card

List of Documents (Indicative)

Proof of Address Proof of Identitiy

KYC (Know Your Customer) Documents

Passport size colored photograph

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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Customers are required to submit at least one of the documents in PoA and PoI listed above.

Documents required for J&K
The Ministry of Telecom has set up specific guidelines for documentation for the J&K region.

The documents authorized by Ministry are as below:

For Proof of Identity
(All Identity proof to contain photograph)

1 Passport
2 Arms Licence
3 Driving Licence
4 Election Commission I Card
5 Ration Card (with photograph of the applicant)
6 CGHS/ECHS Card
7 Address card with photograph issued by Dept. of 

Post, Govt. of India
8 Current Passbook of Post Office/any Scheduled 

Bank with photograph

9 Photo Identity card (of Central Govt./PSU or State 
Govt./PSU only

10 Pensioner’s card with Photograph
11 Freedom Fighter Card with Photograph
12 Kissan Passbook with photograph
13 Income Tax PAN card
14 Photo Credit Card 
15 Smart card issued by CSD, Defence/Paramilitary
16 Photo Identity Card issued by Government 

recognised educational institutions (for students 
only)

For Proof of Address
(All Address proof to contain photograph)

1 Passport
2 Arms Licence
3 Driving Licence
4 Election Commission I Card
5 Ration Card (with address)
6 CGHS/ECHS Card
7 Address card with photograph issued by Dept. of 

Post, Govt. of India
8 Current Passbook of Post Office/any Scheduled 

Bank

9 Photo Identity card with address (of Central Govt./
PSU or State Govt./PSU only

10 Pensioner’s card with Address
11 Freedom Fighter Card with Address
12 Kissan Passbook with Address
13 Income Tax Assessment Order
14 Credit Card Statement (not older than last 3 

months)
15 Telephone Bill or fixed landline (not older than last 

3 months)
16 Permanent Residency Card issued by J&K Govt.

Documents required for North-Eastern states

1. Please furnish proof of identity/address by furnishing any of the following:

 ● Income Tax PAN

 ● Photo Credit Card

 ● Photo Identity Card

 ● Passport

 ● Arms License

 ● Driving License

 ● Any other document containing photograph

2. In case of Govt. of India Undertaking/Govt. of India Officers/ State Govt. Officers, the aforesaid identity/address 
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1. Write down any four documents for proof of address.

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

2. Write down any four documents for proof of identity.

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

self certification should be done on letter head other requirement to be despensed with. Designation of the                          
co-ordinationg office can be consulted in case of need.

3. For foreign missions/foreign agencies operating in India it is important that the name and the designation of the 
officer authorised should be listed along with mobile number where possible. in the case of foreign national and 
station subsciber there local references must be given.

Resource: State Portal of Arunachal Pradesh

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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2.4.1 Attendance and Time in Office

2.4.2 Call Centre Metrics

Office Timings
 ● CCE should reach office on time. 

 ● Ideally one should be in office at least 15 minutes before the start of the shift.

 ● The office duration is generally 9 hours in a call centre.

Call Login Hours
 ● In most organizations, login time is generally 8 hours.

 ● Login time is the time during which an executive is logged into the system and is ready to take calls or is  
       taking a call. Login time also includes hold and wrap-up time. 

Timing for Call (Time Zone)
 ● Operation hours of a company should be in tandem with the time zone of the customers who are being   

 serviced.  

 ● For example, in case clients require us to serve the US customer base, then the call centre staffing should be  
       mapped as per the US time zone.

 ● Holidays of the call centre staff generally depend on the geography of the customers being serviced. 

 ● For example, in case the area of service is South India then, the list of holidays relevant to South India will be  
       applicable.

 ● Average Call Handle Time (ACHT) is measured by the call duration of customer care representative. Lower  
 the ACHT, more is the profitability of business.

 ● AHT refers to Average Hold Time. It indicates the duration for which the executive has placed the customer  
 on hold.

 ● ACHT’s importance to the company is strictly financial and is directly related to the Service Level Agreement.  
 Higher ACHT impacts business profitability, hence, it is important to address the customer queries in a timely  
 manner.

 ● AUX refers to Auxiliary work state. It indicates to the time the call centre agent is unavailable but not working  

UNIT 2.4: Call Centre Specific Concepts

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the key concepts that are specifically related to CCE job
2. Understand concepts like first call resolution, service level agreement and TAT

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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 on wrap-up or other contact-related events. Some call centre’s use Aux (or equivalent) with codes that   
 indicate where the call centre agent’s time is spent - breaks, lunch, training, special projects, etc.

 ● CSAT Surveys- Customer Satisfaction (CSAT) surveys are surveys which are rolled out by the company to involve  
 their quality department in order to obtain a direct feedback from the customers. In telecom call centre a post  
 call CSAT message is sent to the customer after the agent disconnects. This CSAT message is used to determine  
 whether customers are satisfied with their call centre experience. For e.g. the following text message is sent to  
 the customer: “Hi, you just spoke to ABC_9236. Let us know if you were happy with the experience. Reply toll  
 free with ‘Y’ or ‘N’''.

2.4.3 First Call Resolution (FCR)
FCR- First Call Resolution results in

First Call 
Resolution

Satisfied 
Customer

Increased 
Profitability

No Repeat 
Calls

2.4.4 Service Level Agreement
1. SLA takes place between the end client and the service rendering party.

2. SLA involves:

a) Answering certain number of calls in a defined weight threshold. For example: x percent of calls need to be 
answered in y seconds or less.

b) Service level is the most important speed-of-service measure in a call centre.

Fig. 2.4.1 Result of first call resolution
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2.4.5 Response Time/TAT
Turn Around Time (TAT)
It is mandatory to inform the TAT of request/complaint to the customer.

1. TAT for Complaints:

Turn Around Time is the time elapsed between complaint registered and complaint resolved.

2. TAT for Processes, Products and Services:

Might vary from provider to provider. However, general requests like voice mail activation, international dialling 
activation takes around four hours post which customers power cycle their handsets to avail benefits of the services.

Fill in the blanks
1. The office duration is generally ________________________ hours in a call centre.
2. ____________________ is the time during which an executive is logged into the system and is ready to take calls 

or is taking a call.
3. __________________ and _____________________ are the two code of ethics.
4. ACHT refers to _________________________________
5. ______________________ indicates the duration for which the executive has placed the customer on hold.
6. CSAT Surveys can be rolled out via __________________________ or in the form of text messages.
7. _____________________ is the time elapsed between complaint registered and complaint resolved.
8. Customer Retention is linked to customer _________________________ 
9. Your company has launched a new scheme for their customers. How will you ensure that you are fully informed 

about the service?
____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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2.5.1 Workplace Ergonomics

2.5.2 Workplace Timings

Workstation Essentials
Office Furniture

 ● Alwasys use supportive and adjustable chair according to your height. 
 ● A rigid height desk with a adjustable height and footrest must be used in the office. 

Monitor

 ● Height or placing of the monitor screen is at below eye level or top 
 ● Monitor must be placed correctly so that they reduce reflections and glare
 ● While working take regular breaks from sitting and do frequent changes in your postures

Sufficient Work Surface
 ● Workplace area should be good enough so that anyone can enter and move in the workplace smoothly  

 and employees can do frequent changes in their postures easily 
 ● Lockers or Almirah must be allocated to everyone for storage of their material. 

Work Environment 
 ● Normal temperature 
 ● Not too loud
 ● Good lighting and air quality

The CCE gets one hour break during the entire day. The one hour break is divided into three intervals which include 
two short breaks of 15 minutes each and one long break for lunch/dinner of 30 minutes.

UNIT 2.5: You at the Workplace

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the importance of Workplace Ergonomics

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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1. What is Workplace Ergonomics?

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

2. Why is a break required?

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

3. Why do we need respect at workplace? List down five points.

a) ____________________________________________

b) ____________________________________________

c) ____________________________________________

d) ____________________________________________

e) ____________________________________________

4. Demonstrate the following:

a) Your colleague is not feeling well and has to immediately leave from work. What do you do?
________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

2.5.3 Respect at Workplace

Why do we need respect in the workplace?
 ● Improve team communication
 ● Strengthen employee retention
 ● Enhance organizational health
 ● Boost morale

 ● Reduce absenteeism
 ● Create stronger corporate culture and reputation
 ● Increase productivity
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Notes

_______________________________________________________________________________________________
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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b) One of your team members is facing a technical problem during his calls. What do you do to help him?
________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________
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UNIT 2.6: Data Confidentiality

Unit Objectives
At the end of this unit, you will be able to:
1. Know the importance of data confidentiality

2.6.1 Information Security
Data or information is the main asset of an organization and its must be protected. This data could be:

 ● Client information like contact number, financial information, personal information, etc.
 ● The way your organization functions, like its process flow, the way departments work, the names and   

 contact information of those people.  
The policies and procedures of your organization. It is important that as a Customer Care Executive you take all 
measures for information security. Information security is the protection of classified information from unauthorized 
access, use, disclosure, modification, inspection, recording or destruction. This data could be electronic data, physical 
data, etc.

 ● Do not reveal customer’s personal and financial information to anybody other than the account holder.
 ● Classified information, written or verbal, cannot be told to any customer/competitor/any other    

person e.g. photocopy of customer information sheet etc.
 ● Do not share information about a customer with other customers.

2.6.2 Client Confidentiality
The client places a lot of trust in the organization and in the Customer Care Executive before sharing his information. 
It’s crucial for the CCE to maintain that trust and faith by maintaining the confidentiality of the client’s information. 
The measures that many organizations take to maintain data security are:

 ● The personal data received from clients in any form such as hard copies or soft copies is destroyed or returned  
back after the completion of the work.

 ● None of the employees are allowed to bring any storage devices like memory cards, CD/DVD/ Blue Rays Disc,  
 external hard disk, floppy disk, pen drive etc.

 ● At entry and the exit points, the security guards frisk the employees to check that none of the storage   
 devices are carried in or out by any of the employees.

 ● Storage devices such as CDs, DVDs, pen drive, or any other are not allowed in the office premises without prior 
permission from authorized management team members.

 ● Many organisations use professional firewall system to restricts users from surfing or accessing unauthorized 
sites on the internet.

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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1. Why do you think data confidentiality measures are taken in any organization?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

 ● Some companies uses a written Non-Disclosure Agreement (NDA) at the time of joining from each employee.
 ● In many place entrance in operations area is restricted by finger print software, as per the privacy norms.
 ● The server for the website should also be protected and it’s crucial for the CCE to ensure that he doesn’t use or 

access or try to dig for unauthorized information.
 ● Limited access to the network is given through login IDs and password protection.
 ● Passwords and access controls are well defined for authorized internal persons. 

Exercise

Notes
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

38

Participant Handbook

viii

Participant Handbook
Customer Care Executive (Call Centre)

3. Soft Skills and
     Professional Skills

Unit 3.1 – Telephone Etiquette
Unit 3.2 – Dealing with Different Types of Customers
Unit 3.3 – Time Management
Unit 3.4 – Communication Skills
Unit 3.5 – Assertiveness and Decision Making Skills
Unit 3.6 – Objection Handling
Unit 3.7 – Comprehension and Problem Solving Skills
Unit 3.8 – Selling Skills
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3. Soft Skills and
Professional Skills

Unit 3.1 – Telephone Etiquette
Unit 3.2 – Dealing with Different Types of Customers
Unit 3.3 – Time Management
Unit 3.4 – Communication Skills
Unit 3.5 – Assertiveness and Decision Making Skills
Unit 3.6 – Objection Handling
Unit 3.7 – Comprehension and Problem Solving Skills
Unit 3.8 – Selling Skills

TEL/N0100, TEL/N0101,  
TEL/N0102, TEL/N0103,  

TEL/N0104
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At the end of this module, you will be able to:
1.  State the basic etiquettes required for making and attending calls
2.  Show how to open and close a call using predefined scripts
3.  Classify customer behaviour and deal with them accordingly
4.  List the dos and don'ts of dealing with complaints
5.  Explain the importance of time management and that of being organized
6.  Understand the importance of communication in the workplace
7.  Practice effective communication in the workplace
8.  Understand the importance of decision making and assertiveness for your role
9.  Practice decision making skills as required for your role
10.  Handle objections and criticism from the customer with empathy
11.  Identify, comprehend, and resolve customer issues
12.  Recognise the needs of customers and identify ways to influence them to buy

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
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3.1.1 Telephone Etiquette

3.1.2 Sales Call Etiquette

The customer’s impression of a CCE and the organization is influenced entirely by what the CCE says, and even more 
so, by how he/she says it. The voice reveals what a CCE thinks and feels regardless of the words he/she uses.

 ● When picking up the phone, introduce your company and yourself to the caller.
 ● Avoid using bad language or common slangs.
 ● Use these phrases frequently “May I help you”, “You are welcome”, and “Thank you”. 
 ● Treat the receiver with care. Put it down gently. Never slam the phone. 
 ● Try to speak clearly so that the other person can understand what you are saying. 
 ● Understand and practice the procedure for call transfers. When placing a call on hold, inform the caller of the 

same. Use the name of the person you are transferring the call to. 
 ● Be attentive and keep your tone apleasant. 
 ● Listen without interruption. 
 ● Before initiating a call, mentally prepare yourself so that you know what you need to achieve and say.

On a sales call, the customer needs to be convinced and for that it is important that he places his faith in you. He should 
trust you enough over the phone to be convinced to part with his money or at least agree to give you an appointment.
To ensure this, there are scripts which should be followed on a sales call.
Opening Script
“Good morning Mr. ABC This is PQR from XYZ. I'm calling you specifically to tell you about our new IT products which 
will meet your computer and IT related needs. Is this a good time to talk?”
Always ask for permission to continue.
Follow-up Script  
“Good morning Mr ABC. This is PQR from XYZ. I'm calling you today because when we spoke last _________ you asked 
me to call back today to set an appointment. Would Thursday at 1pm be good for you?”

UNIT 3.1: Telephone Etiquettes

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand telephonic etiquette required
2. Demonstrate the opening and closing of a call using predefined scripts

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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Hold

As a Customer Care Executive, it is important that we do not place a call on hold. We should place the call on hold only 
in three circumstances: 

 ● To find any currently unavailable information. 
 ● As a part of the transfer protocol.
 ● To research on the customer’s account.

Before going on hold:
Three important things to be taken care of, when you are putting the customer on hold:

 ● Seek Permission.
 ● State the approximate duration of ‘hold’ (not > 2 min).
 ● State the reason for which ‘hold’ is required. 

Hold Script

“May I place the call on hold for 2 minutes while I check with the engineering department about the time they will take 
to prepare a computer with your desired configurations?” 
After coming back from hold: 

 ● Thank the Customer for his patience.
 ● Appreciate his patience and apologize (if it took you a while to be back or if you have put him on hold for multiple 

times).
“I thank you for being on hold. I thank you for your patience. I have the information required. The engineering team 
suggested that they will be ready with the configuration of your computer in 10 days.”
After every two minutes refresh the hold function and ask the customer’s permission if you think you need more time.
Mute

This is a state of silence over the phone.
Please note: No customer appreciates a state of silence over the phone. Ensure that mute is used only when you have 
to cough, clear your throat, sneeze etc.
Transfer/Escalate
You should try to deal with all the customers’ queries, requests and complaints. However, there are limits to your role 
and there are situations in which you would need to involve others. This is when the customer is to be transferred to 
another department or the supervisor in cases where the CRM is not able to help the customer further.
Ensure that you:
1. Inform the customer 
2. Put the customer on hold
Escalation Script
“May I place the call on hold for 2 minutes, while I inform my supervisor about the concern?”
1. Dial the line. In case you do not get through within the stipulated time, come back and inform the customer again. 

( only in case of Transfer)
2. Educate the agent/supervisor to whom the customer is being transferred to.
3. Come back to the customer and introduce the agent/supervisor.
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4. Close the call from your end.
Ending the Call
End the call in such a way that the customer should want to speak to you later again.
”Mr. ABC, it was pleasure talking to you. Once again, you were speaking to PQR. Please give me a call at this number if 
you have any other computer related need. We will be glad to help you. Thank you for your time. Thank you for calling 
XYZ. Have a nice day.”

1. When you answer the phone, you need to say your name and....?

a) The name of the company

b) “Hello!”

c) How are you today?”

2. Why are telephone greetings so important?

a) It is the first impression

b) It shows that you are happy

c) It shows that you are polite

3. When putting a caller on hold, what do you need to say or ask?

a) May I please put your call on hold?

b) “Would you like to be put on hold?”

c) “I apologise for the inconvenience”

4. While transferring the calls what is better?

a) Transferring the customer’s call directly to the other department/person

b) Connecting with the other department/person yourself, explaining the customer’s query/complaint and then 
personally introducing the customer to the other department executive.

5. You are a CCE of an inbound call centre. How will you open a call with the customer when he calls you?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise
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3.2.1 Customer Behaviour

When dealing with any customer, you should consider factors that may be affecting their behaviour. Choosing the 
correct way of approaching these situations can greatly increase the chance of a positive outcome, and ultimately 
make your job more satisfying.
Angry Customer                                                                                   

A small mistake has made any customer mad.
How to Handle?

 ● Always let the customer finish talking. Don’t interrupt customer in the conversation.
 ● Be polite in the conversation.

Demanding Customer                                                                                            

The customer who always need more than you can offer to him/her. This type of customers are not easily satisfied.
How to Handle?

 ● Be professional and stay polite at the time of handling.
 ● Don't be rude with the customers in the conversation but also remember not to being too friendly.

Passive Customer                                                                                                

The customer who always listens you carefully and when complaining they will sound apologetic.
How to Handle?

 ● The tone of your voice must be sound professional at the time of conversation.
 ● Carefully listen to the customer.
 ● Increase their confidence in the conversation.

3.2.2 Dealing with Complaints

Impulsive Customer                                                                                                

These Customers are difficult to advice as they want to buy in urge but don't have any specifications in mind.
How to Handle?

 ● Display all the useful products in front of the customers.
 ● Give as much information as you can.

UNIT 3.2: Dealing with Different Types of Customers

Unit Objectives
At the end of this unit, you will be able to:
1. Clarify customer behaviour and deal with them according to the situation and their mood
2. List the dos and don'ts of dealing with complaints

About this book
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       Dos      Don'ts

 ● Keep breathing normally
 ● Keep your tone normal and friendly
 ● Listen to what the customer is saying
 ● Keep taking notes

 ● If organization is at fault, apologise
 ● Never give excuses
 ● If you promise something, do it

 ● Try to avoid the calls 
 ● Say it’s not my fault
 ● Say I didn’t deal with this
 ● Lose your temper 
 ● Appeal  for sympathy
 ● Jump to conclusions
 ● Interrupt 

Need-based customers: These customers are product-specific and only tend to buy items which they are habitual to 
or have a specific need.
How to Handle?

 ● Handle positively, give them ways and reasons to switch to other division products.
 ● Identify and confirm customer expectations.

How will you handle a customer who...
1. Feels that you are trying to fool him with your products/services?

____________________________________________________________________________________________

2. Doesn't know what he wants from the services?
____________________________________________________________________________________________

3. Knows everything about the service and is angry because of something?
____________________________________________________________________________________________

What will you do in the following situations?
1. An angry customer, who feels let down by service offered by one of the CCE, is demanding an apology by CCE.

____________________________________________________________________________________________

2. Customer has called up to deactivate the ring tone which was earlier activated against his wish. The issue has not 
been sorted out in last 31 days.
____________________________________________________________________________________________

3. Customer wants to change his plan and is not able to decide which plan to choose, help him choose the right plan.
____________________________________________________________________________________________

Practical

Exercise
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UNIT 3.3: Time Management

3.3.1 Time Management
Understanding Time Management

 ● Time Management means using our time in a way so that the right time is allocated to the right activity.
 ● Effective time management enables us to give specific time slots to specific activities as per their importance.
 ● It means making the best use of time as time is limited.

Features of Time Management
1. Setting goals and objectives
2. Setting deadlines
3. Delegrating responsibilities 
4. Setting priorities for each activity
5. Spending the right time on the right activity

Urgent and Important Tasks Non-Urgent but Important Tasks
DO NOW
Handle customer complaints and issues
Demands from superiors
Meetings with superiors

PLAN TO DO THEM
Planning and scheduling of next day activities
Preparing or updating daily report

Non-Important but Urgent Tasks Non-Important and Non-Urgent Tasks
REJECT AND EXPLAIN 

Trivial requests from customers
Apparent emergencies
Misunderstandings appearing in work

Pointless routines or activities

RESIST AND CEASE
Playing computer games
Net surfing
Excessive cigarette breaks
Engage in chat, gossip, social communications
Reading irrelevant and useless material

3.3.2 Being Punctual

 ● Strengthens and reveals your integrity
 ● Shows you are dependable

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the importance of time management and being organised at the workplace
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3.3.3 Being Organised
 ● Being more focused and goal-oriented
 ● Being more productive
 ● Providing a good example for those that work with you and for you
 ● Working more economically, e.g. eliminating missed payments and late fees
 ● Reduction in work clutter and consequently reduction in stress
 ● Achieving a better work-life balance, which is very good for your health
 ● Setting and reaching goals more efficiently
 ● Presenting a more positive business image and thus gain a better reputation

1. List down your activities for a day. Then arrange them on the basis of their priority. Identify what is important and 
what is not so important?

____________________________________________________________________________________________

____________________________________________________________________________________________ 

2. What can you do to make sure that you are managing your time efficiently?

____________________________________________________________________________________________

____________________________________________________________________________________________

 ● Prioritize

 ● Work on the things timely

 ● Appropriate prioritisation of tasks
 ● Becoming more flexible and more creative
 ● Achieving more energy and enthusiasm for what you’re doing
 ● Finding freedom from chaos and disorder
 ● Reduction in obsolete or unneeded items
 ● Increase in income from attention spent on bringing in new business and maintaining current customer 

satisfaction

 ● Builds your self-confidence
 ● Shows your respect for others
 ● Shows your humility

Exercise
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3.4.1 Communication Skills
What is Communication?

 ● Communication is the process of sending and receiving information among people.
 ● The purpose of communication is to get your message across to others. In fact, a message is successful only 

when both the sender and the receiver perceive it in the same way.
Why is Communication Important?

 ● Communication is the basis of our career and personal lives
 ● Helps in build respect in different aspects of life
 ● It helps to make friends
 ● It forms a ditinct pack of our personalty 
 ● It reveals our ability to other

Essentials of Good Communication
For effective communication, the CCE has to focus on four important things. They are:
1. Understand the customer's communication style
2. Clarity in communication
3. The art of listening
4. The art of asking questions

3.4.2 Clarity in Communication
The Customer Care Executive should clearly communicate with peers/seniors about tasks at the Call Centre. Always 
communicate in a way that shows respect for your listeners and send your meaning to them. To communicate clearly, 
always be sure of following things:

UNIT 3.4: Communication Skills

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the importance of communication in the workplace
2. Practice effective communication in the workplace
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Effective listening is an active endeavour. It’s much more than just hearing what customers say. Good listeners project 
themselves into the customer’s mind. Through effective listening, the Customer Care Executive demonstrates concern 
for the customer’s needs by selecting appropriate merchandise to present to the customers.
Techniques for active listening include:

 ● Repeating or rephrasing information
 ● Summarizing conversations
 ● Tolerating silences

3.4.3 The Art of Listening

 ● Know the meaning of your sentence before speak, first you should understand what you want to achieve after 
the communication.

 ● Always talk on main points. If you are giving extra information which is not related to the customer queries than  
your customer may get confused. 

 ● At the time of speaking, always try to avoid making libelous remarks and give your best to focus on the customer 
behaviour.

3.4.4 The Art of Asking Questions/Probing
Executives should ask questions for several reasons. First, questions get the customer to participate in the sales process. 
By asking questions, executives encourage customers to actively engage in a conversation rather than passively listening 
to them. Participating in a conversation makes them more likely to hear and remember what’s said. Second, questions 
show customers that the salesperson is interested in them. Finally, salespeople can collect valuable information using 
questions.

Here are some guidelines for effective questioning:
 ● Encourage longer responses. Don’t ask questions that can be answered with a simple “Yes” or “No”. For example, 

ask, “What do you know about this brand?” rather than “Have you heard of this brand?”
 ● Space out questions. When an executive asks several questions one right after the other, customers may feel 

threatened. One method for spacing out questions is to encourage customers to elaborate on their responses.
 ● Ask short, simple questions. Avoid questions with two or more parts. When faced with complex questions, 

customers might not know which part to answer, and the salesperson might not know which part of the question 
is being answered.

 ● Avoiding leading questions. Leading questions just put words into the customer’s mouth and don’t tell the 
salesperson what the customer is actually thinking. The question –Why do you think this is a good service?” gets 
at a customer’s positive thoughts but doesn’t reveal their reservations.
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1. Share an experience when you were angry with someone for not paying proper attention to you while you were 
talking.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Practical

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

1. Why is communication important?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise
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UNIT 3.5: Assertiveness and Decision Making Skills

3.5.1 Assertiveness

3.5.2 Decision Making Skills

Sometimes a customer will demand special attention and will ask for every favour he/she can get. A CCE should be able 
to communicate clearly what kind of behaviour is acceptable and what is not. This doesn’t mean putting a customer 
back in his/her place in an aggressive manner. A CCE is just communicating what he/she wants in a calm and assertive 
manner.
Assertive Individuals 

 ● Stand up for their rights while respecting the rights of others.
 ● Communicate what they want in a clear manner.
 ● Have positive self-esteem and a good self-image.

Being Assertive
 ● While on phone use a pleasant firm voice, have clear pronunciation, maintain moderate speed and pitch, must 

have proper information. 

One good customer service skills you can have is the skill to make good decisions. When your customer has a prob-
lem you have to decide what action to take and how to fix it. If you don’t do anything you’ll have one grumpy client.
You have to see which decisions has the biggest benefit. You have to ask yourself what choice will make the biggest 
positive impact. Always take action.
As a customer service representative you are responsible for helping the customer out as best as you can. You can 
help him in various ways. Maybe you only have to point out certain facts to them. Maybe you have to patch them 
through to the right department. Any way you have to help the customer as best as you can.
Anatomy of a Decision
1. Identify the problem/ goal
2. Get information
3. Think of alternative

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the importance of assertiveness
2. Understand the importance of decision making skills

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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1. Tick the assertive statement

Read the following statements made by Employee 1 to 5. Now tick the assertive statements.

Manager: Though it is 7pm, I want you to finish the work today itself. We have to deliver this tomorrow at 11 a.m.

a) Employee 1: This is very difficult. I am sorry but I cannot do this. My working hours get over at 5.30 pm.

b) Employee 2: Okay but it is really difficult. If you still insist, I will do it.

c) Employee 3: No, this cannot be done. My wife is not well. I have to be back home on time. I am already late.

d) Employee 4: Yes, I understand but it is difficult for me to stay back. I am taking some work home. I can be in 
office early tomorrow and can finish off the rest.

e) Employee 5: This can be done tomorrow too. If you pressurize, I cannot help it.

2. Imagine a situation when you as a CCE has to tell a customer that his problem can be solved only in a day’s time and 
not in an hour. The customer is arguing that he wants it to be fixed as soon as possible. What will you do?

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

3. Think of a situation in your personal life when you had to take a decision. What all things you considered before 
taking the decision? Share the experience.

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

4. Choose the optimum solution
5. Implement your decision

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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UNIT 3.6: Objection Handling

3.6.2 Coping with Criticism

3.6.1 Objection Handling

Responding calmly and rationally to unwarranted criticism:
Dealing with your Initial Response
 Your immediate response is the most important – it has the greatest scope for making things easier or difficult. The 
recommended approach to overcome the natural urge to express your anger or fight back:

 ● Remain calm
 ● Have the point repeated
 ● Open up both perspectives
 ● Move on politely

When you are selling a product or service in your business, you need to be able to anticipate and handle your cus-
tomers objections as they arise. Your business will also benefit from your ability to recognise, follow-up and convert 
good leads into sales.

3.6.3 Express Empathy to Customers
Use Empathic Phrases: 

 ● “I can see why you feel that way”
 ● “I see what you mean”
 ● “That must be very upsetting”
 ● “I understand how frustrating this must be”
 ● “I’m sorry about this”

For example: A customer calls at the customer care and lodges a complaint of not rendering a particular service. 
You can answer him/her as:

Unit Objectives
At the end of this unit, you will be able to:
1. Handle objections and criticism
2. Empathize with customer's problems, criticism, and suggestions

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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Fill in the blanks:

1. Stepping into customer’s shoes is called ____________________.

2. A ______________ attitude will help the customers understand that you are selling a good product or a service.

1. An irate customer calls you with a complaint that his mobile network always troubles him during his travel. How 
will you handle it?

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

“As I understand it, you are quite rightly upset because we were not able to enable the telecom services that we 
promised you last week”.
Or
 “I understand why you are upset. I would be too. I am very sorry that we didn’t get the service to you on time”.
Or
“I am right away taking your complaint to the concerned department.
It will be solved in next three hours.''

Exercise

Practical

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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UNIT 3.7: Comprehension and Problem Solving Skills

3.7.1 Problem Solving Skills

For a CCE to work effectively and efficiently, it is necessary to identify and comprehend problems right at the first step. 
It helps in achieving more work in less time. 

Problem-Solving

 ● Identify the problem
 ● Generate alternative solutions
 ● Evaluate the solution
 ● Choose the best/ optimum among the alternative solutions
 ● Implement and evaluate the chosen solution

Problem Solving Examples
 ● At the billing counter the customer line-up is moving too slowly - The CCE should stop all unnecessary conversation 

with the customers and refer complex matters to the senior executive. 
 ● Angry customers who are not happy with the service or with the procedure - CCE must attempt to cool the 

customers, discover the source of unhappiness and provide a remedy if possible. 
 ● In case of a bank payments have not been properly credited to a customer’s account - CCE again reassure the 

customer to trace what happens.
 ● Some information is missing from a customer’s account - CCE must check files and talk to co-workers to locate the 

missing documentation. 
 ● At the billing desk the cash does not balance at the end of the day - CCE must try to find the error. If an error is not 

found, they may have to reimburse the difference themselves.

Unit Objectives
At the end of this unit, you will be able to:
1. Identify customer’s problems and offer a solution to them

About this book
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2. List any two barriers to effective problem solving.

a. ______________________________________________________________________

b. ______________________________________________________________________

1. Imagine that the payments have not been properly credited to a customer’s account. What do you do to solve 
the problem?

 _______________________________________________________________________________

 _______________________________________________________________________________

              _______________________________________________________________________________

 _______________________________________________________________________________

Exercise

Practical
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1. Choose any example from above and solve it using the following 3 steps:

a. Identify and comprehend the problem

b. Problem solving process

c. Educate customer & communicating the resolution
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UNIT 3.8: Selling Skills

3.8.1 Selling Skills

What is Selling?

Selling is trying to make sales by persuading someone to buy one’s product or service. It has different parts like 
advertising, promotion, public relations and direct marketing. Selling involves a salesperson who helps the customer 
fulfill his needs and facilitates the matching of what you have to offer with what the buyer wants to buy. 
Selling Process

Before the Sale - Preparation:
 ● Know your products, competitors
 ● Know your customer
 ● Be informed about current sales and promotion
 ● Know about payment plan and modes of payment

During the Sale- Approach and Greeting:
 ● Describe product plan and features
 ● Recommend and help customer choose the right plan

After the Sale - Building Future Relationship:
 ● Customer queries and complaints
 ● Up-selling 
 ● Cross-selling

Unit Objectives
At the end of this unit, you will be able to:
1. Recognise the need of customers and how to influence them to buy
2. Understand the sales process

3.8.2 While Taking an Order
There are situations where the customer has called to place an order. You need to be a good listener and need to pay 
attention to details. It will be an advantage if you know all the products offered by your company, so that you can offer 
the customers more choice. In such a case:  
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STEP 1: Always open by greeting the customer. Next confirm that the call is to place an order. Confirm the product 
name in full. 

STEP 2: Read the script slowly and clearly. Do not hurry or mumble. Ask for the customer’s details first. This way, if you 
have a repeat customer, the details will show up on your computer.

STEP 3: Type in the details provided by the customer accurately into the application.

STEP 4: Assure the customer that you are selling an excellent product.

STEP 5: Confirm the mode of payment, whether by cash or credit card.

STEP 6: Remember to repeat the order clearly and completely. Confirm the amount to be paid by the customer.

STEP 7: Mention the delivery time in terms of the working days. Be sure of the delivery time before you commit to 
the customer.

STEP 8: Leave the customer by giving a customer service number for further help. Ask if there is anything else you can 
do to help.

1. What do you think is the purpose of sales?

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

2. List any four barriers to effective problem solving.

a) ________________________________________________________________________________________

b) ________________________________________________________________________________________

c) ________________________________________________________________________________________

d) ________________________________________________________________________________________

Exercise
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1. You have to call a customer and sell a new scheme that your organization has launched. How will you sell the 
service?

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________
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At the end of this module, you will be able to:
1.  Use CRM effectively with complete and correct tagging
2.  Explain how to make and attend calls
3.  Demonstrate how to do call transfer, call hold and call forward.
4.  Demonstrate the usage of different IT applications used to search customer details in the database
5.  Show how to fetch information about products, processes and services for the customer

Key Learning Outcomes
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UNIT 4.1: Understanding CRM

4.1.1 CRM

4.1.2 Benefits of CRM

What is CRM?

An acronym for Customer Relationship Management, the term refers to a systematic approach to handling customer 
relationships.

How Does CRM Benefit your Business?
CRM benefits are often misunderstood as an application or a tool, but in the real sense of the term it is a way of doing 
business. There can be innumerable reasons for businesses to implement CRM. However, let’s take a look at few of the 
most apparent benefits of using CRM.

 ● 360 degree view of business
 ● Organizational-level data sharing
 ● Centralized customer interaction
 ● Improved customer support
 ● Increased customer satisfaction
 ● High rate of customer retention
 ● Boosts new business
 ● Increased revenue at low cost

CRM when used efficiently and effectively can have the above benefits. But how do we use it effectively?
 ● Update information accurately
 ● Update complete information
 ● Update all customer requirements
 ● Ensure that you save and submit information
 ● Check for old information and update the same when required
 ● Check for missing information and update if you see anything blank

Before you update CRM or any kind of customer information it is important to identify if you are speaking to the right 
person. How do you know that you are speaking to the right person?

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the concept and benefits of CRM

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1. What is CRM?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. What are common security questions?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

3. Why is it important to verify a caller?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Identification & Verification is the process to check if you are speaking to the right person. Let us look at some common 
questions asked for verification in the telecom industry:

 ● Complete Name
 ● Date of Birth
 ● Last Paid Bill Amount
 ● Billing Address

After you complete the call, the reason the customer made the call needs to be categorised, this will allow a telecom 
company to understand customer needs and concerns.
With the evolution of CRM system and process there is a call tag type for almost every question your customer has. 
All you need to do is understand the customer’s query and match it to the broad category e.g. Tariff Plan, Value added 
service, complaints, billing information, active VAS, General, blank call etc.

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

65

Customer Care Executive (Call Centre)Customer Care Executive (Call Centre)

UNIT 4.2: Making and Receiving Calls

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of Making and Receiving Calls
2. Demonstrate how to make and recieve calls
3. Demonstrate how to do call transfers, call hold and call forward 

4.2.1 Making and Receiving Calls
How to Make and Receive Calls

Technology which a CCE needs to familiarize himself with at a call centre goes beyond computers.  Call centres today 
also have advanced telephones.
Telephone sets may look complicated but are really easy to use.

How to Make and Receive Calls

In a call centre it is important to work with technology, and technology does not only relate to computers. Call centre 
today also have advanced with telephones.

Telephone sets may look complicated but are really easy to use. Lets look at some telephone sets and large service 
providers.

Like a mobile phone these sets have a manual button to answer a call, however mostly all call centres today have an 
auto answer mode set as default to 1 ring. But if you do have a manual answer facility make sure that you answer the 
call in 2 rings as this gives you enough time to prepare for the opening and also does not make your customer wait long.

CISCO AVAYA ASPECT
Fig. 4.2.1 Types of telephones

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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1. Within how many seconds should you answer a call?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

1. Use the mobile to demonstrate the call answering time and hold process

 ________________________________________________________________________________________

 ________________________________________________________________________________________

              ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

Exercise

Practical

4.2.2 Concept of Call Transfer, Call Hold and Call Forward
We all know that working in telecom industry is a complex process as not all issues can be resolved by 1 person, you 
will need to transfer the call to other departments and for this telephone sets are built to handle this function easily 
and is really simple. Lets look at what buttons you need to press to transfer a call:

1. Press on hold
2. Dial department number
3. Press on conference
4. Press release or transfer to exit

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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Notes
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2. Use your mobile to demonstrate call transfer process

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

              ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________

 ________________________________________________________________________________________
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4.3.1 Various Software Applications

4.3.2 Swapping 

Telecom Call Centre Executives will need to work on multiple applications like:
 ● Intranet site and Call taking application
 ● Customer Information System and account information
 ● Call Log and Billing System

Intranet Site

You will need to look at company's intranet site for new products and features.

Call Taking Application
Telephone sets with today’s technology can be operated through your computer, you will need to use that application 
for hold, transfer and conferencing of calls.

Customer Information System
Since telecom industries have a lot of varied information about customers they usually use different applications to 
maintain information in an organised manner. You will need to use the customer information system to access personal 
information about the customer.

Account Information
Like customer information, account related information is also maintained differently. However, it is linked to the 
customer information. If you need to check information on tariff and other Value Added Services (VAS), you would 
need to look into the account information screens.

Call Log and Billing Information
Financial and closely related information is stored in a different set as this is critical and any mistakes can lead to a 
direct financial loss.

It is important to swap between applications quickly while on calls as this can play a major role in reducing your AHT. 
Here are some tips on how you can efficiently swap between screens.

 ● Use the keyboard

UNIT 4.3: Understanding and Using Software Applications

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand different software applications used
2. Explain different software applications used to search customer details in database
3. Use relevant applications effectively

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

69

Customer Care Executive (Call Centre)Customer Care Executive (Call Centre)

 ● Know where to find the requested information

 ● Ensure you login to all the required applications

 ● Ensure that you have tagged the call once you finish

 ● Make sure that your computer is unlocked while you are at your desk

1. What are different applications on which a Customer Care Executive needs to work?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. What is the importance of switching between different applications?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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5. Computer Knowledge
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At the end of this module, you will be able to:
1. Know what is a computer and its different parts
2. Understand about MS Word 
3. Understand about MS Excel 
4. Understand about Internet and network 

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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5.1.1 Computer

5.1.2 Computer Hardware

A computer is an electronic device which was invented by 
Charles Babbage. Its main function is to receives data as input, 
processes it, and generates result as an output. It can also 
carry out a set of arithmetic or logical operations automatically 
and can solve more than one kind of problem. A Computer 
generally uses English language for INPUT and OUTPUT.

Computer hardware comprises of the following:

1. Input devices- It helps in inputting data into a computer so that it can be processed into an information. Examples 
of such devices are keyboard and mouse

2. Processing Devices

Processing device are the one which process the data into 

information. Examples of such devices are CPU, motherboard. 

3. Output Devices 

Output device outputs the processed information. Example of such devices are monitor, printer.

UNIT 5.1: Introduction to Computer

At the end of this unit, you will be able to: 
1. Know what is a computer and its different parts

Unit Objectives

Fig. 5.1.1 Computer

Fig. 5.1.2 Keyboard
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4. Storage Devices 
It provides the computer the means of storing the information it has processed. 
Examples of such devices are hard drive, internal memory, USB drive.

5.1.3 Software
Software is a collection of instructions that can be ‘run’ on a 
computer. These instructions tell the computer what to do. 
Software is instructions that tell computer hardware what to do. 
Software are divided into two parts:
1. System Software
2. Application Software 
System Software: An operating system or OS is a System Software 
that enables the computer hardware to communicate and operate 
with the application software or the user. Without a computer 
System Software, a computer and application programs would be 

Fig. 5.1.3 Monitor Fig. 5.1.4 Printer

Fig. 5.1.5 Hard disk Fig. 5.1.6 RAM Fig. 5.1.7 USB drive

useless. This is an interface between Hardware and user/application software. Windows XP, Windows 7, Windows 
8, Mac OS, Linux, Unix etc. are the OSs and used as a system software. Other types of System Software are 'System 
Utilities' and 'Language Translators'.
Application Software: Application software is a program or group of programs designed for end users. Application 
software resides above system software and includes database programs, word processors, spreadsheets, etc. 
Application software may be grouped along with system software or published alone. In the subsequent chapters of 
this unit, you will learn in detail about Application Software like MS Word, MS Excel and MS PowerPoint that are the 
part of the MS office Package. Although the basic knowledge about the MS Office package is given here.
MS Office: Microsoft Office provides a software for efficiently managing your business information, personal 
information and communication tasks. This unit introduces the individual Office applications and teaches you skills to 
start using them. Microsoft Office provides the following toolkits:

Fig. 5.1.8 Application software in window
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 ● Microsoft Office Word
 ● Microsoft Office Excel
 ● Microsoft Office PowerPoint
 ● Microsoft Office Outlook
 ● Microsoft Office Publisher 
 ● Microsoft Office Access
 ● Microsoft Office OneNote
 ● Microsoft Office InfoPath

In this unit, we shall learn about MS word, MS Excel and MS PowerPoint.
MS Word: It is used for word processing - typing, editing, and formatting letters, reports, fax cover sheets, etc. Word 
enables you to need to create a memo at the office or a letter at home, using a computer Its features can help you 
create sophisticated and professional text more quickly with many features such as footnotes, fonts etc. We will learn 
about these various features of word in this unit:

 ● Templates - A template is a starter document that supplies the document design, text formatting, and often, 
placeholder text or suggested text. Add your own text and your document is finished.

 ● Styles - This refers to formatting settings that you can applied to some text, you can save the combination as a style 
that you can easily apply to other text.

 ● Tables - Word allow you to add a table grid to organise text in a grid of rows and columns to which you can apply 
tabel formatting.

 ● Graphics - You can add all types of pictures into your documents and even create charts and diagrams.
MS Excel: Spreadsheet provides formulas and functions that make it easy to present and calculate numerical data. 
Business people don't need to depend on calculators or accountants to perform complicated sales or financial 
calculations. Even a beginner  can  enter some numbers into the spreadsheet and use a few formulas to calculate data. 

Fig. 5.1.9 MS Word

Quick access toolbar 
Ribbon

Status bar

Title bar Ruler Help

Dialog box launcher

Performance area View buttons
Zoom control
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Microsoft Office PowerPoint: The Microsoft Office PowerPoint presentation has features for communicate information 
and ideas through via an onscreen slide show which can be printed. Every slide can present a different picture. Thus, 
PowerPoint helps to divide information into chunks that audience can absorb more easily. Let us see some main 
themes of the Powerpoint.

Fig. 5.1.10 MS excel

Microsoft Office Excel enables you to do a calculation 
by creating a formula that specifies what values to 
calculate and what mathematical operators to use to 
perform the calculation. Excel also has predesigned 
formulas to perform more complex calculations, such 
as accrued interest, etc.Excel provides tools to assist in 
building and error-checking spreadsheet formulas and 
also gives many choices for formatting the data to make 
it more readable and professional. Let us see some 
excel features:

 ● Worksheets - Excel has file and inside each file, 
one can divide and organise a large amount of data 
across multiple worksheets or pages of information in the file.

 ● Ranges - Excels allow one to assign a name to a section of data on a worksheet so that you can later select that 
area by name, or use the name in a formula to save time.

 ● Number and Date Value Formatting - Excels features allow for applying a number format. A number should be 
displayed indicating details such as how many decimal points should appear and whether a percentage or dollar 
sign should be included. You also can apply a date format to determine how a date appears.

 ● Charts - Excel can help in translate your data into a meaningful image by creating a chart. There are dozens of chart 
types, layouts, and formats in excel to help you present your results in the clearest way.

Fig. 5.1.11 MS powerpoint

 ● Layouts - Themes and Masters. These 
PowerPoint features control the presentation 
of content that appears on a slide and its 
presentation. One can design with ease a single 
slide or the complete presentation.

 ● Tables and Charts - PowerPoint enables you to 
arrange information in formatted grid of rows 
and columns like word and excel. Powerpoint 
can be used with excel to deliver the data you 
have charted in excel.

 ● Animations and Transitions - Powerpoint also 
allow you to set up the text and other items on 
the slide to make a special appearance, such as 
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fly onto the screen, when you play the slide show. You can also apply animation to a transition & see how the 
overall slide appears onscreen, such as dissolving or wiping in.

 ● Live Presentations - PowerPoint offers a number features to customise and control how the presentation looks 
when played as an onscreen slide show. For example hiding slides or jumping between slides onscreen.

Starting an Application (Windows 7 or earlier)
1. Click the Start button at the left end of the taskbar or press the Windows key. This will open the start menu.
2. Click on Programs/All Programs. A list of available programs appears. In XP, it will appears as a submenu of the 

Start menu. In Windows 7, the list appears in the left column of the Start menu.
3. Click on Microsoft Office, the available Office programs appear.
4. Click the desired Office program. The program window appears onscreen.
Closing an Application: When you finish your work in an application, you can shut the application, this will remove it 
from the system memory. Closing the application also provides the possibility of sensitive open files to be viewed by 
others users. You can use any of the below methods to shut down a program:

 ● Press Alt+F4 
 ● Click the program window Close (X) button

If you see a message box with a yes/no to save your work, it means you haven't saved all your changes to the file. Click 
Yes to save the changes to the work you have done. 

1. Identify the input devices:
a. Monitor

b. Printer
c. Keyboard
d. Mouse

2. Identify the output devices:
a. Monitor

b. Printer
c. Keyboard
d. Mouse

3. Which of the following is not a storage device?
a. Pen drive
b. Hard drive
c. Mouse

d. RAM

Exercise
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5.2.1 Microsoft Word

5.2.2 Starting With MS-Word

Microsoft word is basically used for tying 
letters, reports and other documents. In 
this unit we will learning about the basics 
of Microsoft Word.

Opening Word 
There may be a short cut  to open the word file on your system, if it is there double click on that icon in order to open 
the word on your system, if not follow the steps below: 
1. Go the start button 
2. Go to Programs
3. From there go to highlight Microsoft Office
4. Click on Microsoft Word
Creating a New Document
1. Click the File tab and then click on New
2. Click on the Blank Document

3. Then Click on Create     

Opening a Current/ Already Stored Document
1. Click the File tab and then click on Open
2. Click the required document and then click on Open 

UNIT 5.2: Microsoft Word 

At the end of this unit, you will be able to: 
1. Understand the use of MS-Word

Unit Objectives

Fig. 5.2.1 MS word
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5.2.3 The Title Bar

5.2.4 The Ribbon 

The title bar is a bar located at the top of a window that displays the name of the file being used. For example, as can 
be seen in the picture below, the title bar gives the name of the program and document currently being edited.
Quick Access Toolbar: The Quick Access Toolbar has many commands ready for use. It is located at the top left of the 
document above the File and Home tab. 
It has an undo and redo tab to correct errors in your documents. If you click on the Undo command and it will undo 
the last thing you did. 
Windows Control Buttons: These buttons appear on the top right corner of the application. You can use these buttons 
to minimise, maximise, restore, move or close the application.

The ribbon has all the information of Microsoft Office in a visual, streamlined manner through a series of tabs that 
include program features.
Home Tab: Home tab consists of text formatting features like font size, font style, paragraph changes etc. 

Insert Tab: Through this tab on can get an access to insert variety of items such as tables, pictures, header footer, clip 
art etc.

Page Layout Tab: This tab allows you to access various features like adjusting page margins, page orientation, page 
background, inserting columns etc.

Fig. 5.2.2 Title Bar

Fig. 5.2.3 Home tab

Fig. 5.2.4 Insert tab

Fig. 5.2.5 Page layout tab
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Mailing Tab: This tab is used when you need to send a mail. It consists of features such as mail merge, envelopes, 
labels etc.

Review Tab: With the help of this tab you can review your document and rectify spelling and grammar issues. It also 
consists of track changes features which helps to identify the changes made in a document.

5.2.5 Typing Text
You need to keep the cursor from where you want to begin typing. If you want to type from the down instead of top, 
press ENTER till the point the cursor reaches the place from where you want to begin typing.

If you want to begin another paragraph you must press 
enter key. Enter key is also used to give space between 
two paragraphs.
If you want to erase the incorrect words or characters 
appearing on the left of insertion point, press BACKSPACE 
key. If you want to erase the words or characters on the 
right side of the cursor, press DELETE key.

Fig. 5.2.6 Reference tab

Fig. 5.2.7 Mailing tab

Fig. 5.2.8 Review Tab

Fig. 5.2.9 View tab

Fig. 5.2.10 Typing text in a word document

Reference Tab: This tab comprises of table of contents, footnotes, captions, index, table of authorities etc.
 

View Tab: This tab allows you to view your document the way you want. For example if you want to view the document 
by using zoom feature you can view it.
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5.2.6 Formatting Text
Character Formatting 

 ● Font: A group of characters that have a similar 
appearance.

 ● Font Attributes: Additions that enhance your font for 
emphasis. 

 ● Font Size: The size of characters. 
 ● Type Face: A set of characters with a common style and design. 
 ● Bold/Boldface: A formatting option that makes selected words darker than normal. 
 ● Italics: Characters are evenly slanted towards the right. 
 ● Subscript: Text that has been lowered vertically i.e. H2O, 2 is in subscripted form.
 ● Superscript: Text that has been raised vertically i.e. X2 , 2 is in superscript form.
 ● Underline: A horizontal line that is placed beneath characters. 
 ● Bulleted List: A list of key points, each preceded by a symbol for emphasis. 
 ● Modify Fonts: The font section allows you to change text font size, colour, style and several other elements. 

5.2.7 Formatting Documents 
Adjusting Line Spacing 
The default spacing is 1.15 line spacing and 10 points after each 
paragraph. The default spacing in earlier MS Word documents is 
1.0 between lines and no blank line between paragraphs. 
The simplest way to change the line spacing for any document is 
to highlight the paragraphs or the complete document for which 
you want to change the line spacing. 

1. In the paragraph group, go to home tab and click on line spacing. 
2. Do one of the following: 

 ● Select the number of line spaces you want for example, click 1.0 for 
single space and 2.0 for double space.

 ● Select remove space before the paragraph if you want to remove 
additional lines which are added by default after each paragraph.

Fig. 5.2.11 Formatting text

Fig. 5.2.12 Adjusting line space

Fig. 5.2.13 Adjusting line space

Earlier Word versions Newer Word versions
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Paragraph Formatting 
 ● Alignment: It is the way in which lines of text are arranged i.e. full, left, 

right, center.
 ● Full Justified: In this case the lines of text are both right and left aligned.
 ● Left Justification: This is the alignment in which a document is allowed to 

have an even left alignment.
 ● Right Justification: This is the alignment in which a document is allowed to 

have an even right alignment.
 ● Centre Justification: This feature aligns the text horizontally on both the 

sides.
 ● Line Spacing: It is used to provide space between lines in a document i.e. 

single line, double line, triple line, etc. 
 ● Page Break: It shows that the maximum number of lines have been keyed 

on one page and a new page is beginning.
 ●  Tab Key: It allows the user to move the cursor a predetermined number of 

spaces.

Page Orientation 

Bullets or numbers can be added to the existing lines of text or word will 
create lists automatically as you type. 

Inserting Bullets or Numbers:
1. Click on the area where you would like add bullets or numbers.
2. Go to the Paragraph group and click on Bullets or Numbers.
3. Bullets or Numbers will be inserted. 
Select Bullets or Numbering Style: 

1. Select the items for which you want to change bullets or numbering 
styles.

2. On the Home tab click the arrow next to the Bullets or Numbering 
command. 

3. Select the bullet or number format you want to use.
Working with Graphics

Inserting Shapes: There are multiple shapes which can be used in a word 
document. There are lines, arrows, basic geometric shapes, flowchart 

Select either Landscape (horizontal) or Portrait (vertical) 
ororientation for your document. 
Changing Page Orientation
1. Go to page layout, in the Page Setup section and click on 

Orientation.
2. Click on Landscape or Portrait as required.
Bulleted or Numbered List:

Fig. 5.2.14 Paragraph formatting

Fig. 5.2.15 Page orientation

Fig. 5.2.16 Bullet/number list

Fig. 5.2.17 Bullet/number style
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shapes, equation shapes, banners, callouts and stars. After adding one or more 
shapes, you can add text, bullets, numbering, and Quick Styles to them. 
1. In the Illustrations group, go to Insert tab and click on Shapes. 
2. There will be a drop down menu, you need to click on the shape that you 

want to use in the file. 
3. Drag to place the shape wherever you want to use in the document. 

Delete Shapes:  If you want to delete a shape that you don't want, click on that 
shape and press on the delete. 
For inserting Text Boxes: A text box lets you type text anywhere in your 
document.
1. In the Text group, go to the Insert tab and click on Text Box, a drop down 

menu will be visible.
2. Click on a text box and then click Draw Text Box at the bottom of the drop 

down menu that provide the option to draw a text box. 
3. To add text, click in the text box and then paste or type the text in your file.
4. To format text in any text box, select the required text, and using the 

formatting option you can change the text.
5. For changing the position of the text box, click on it and then when a pointer becomes an arrow, drag the text box 

to the required location.
Word Art: Word Art is basically used to add special text effects to your document. For example, you can stretch a title, 
skew text, make text fit a pre-set shape, or apply a gradient fill. If you want to add Word Art to text in your document, 
the following steps must be followed: 
1. Go to the Insert tab, in the Text group, and click on the Word Art.
2. A Drop down menu shall appear and then click on the Word Art Style that you require.
3. A Text Box will appear with the words “Enter your text here” where you can enter the required text. 
Insert Clip Art: 

1. In the Illustrations group, go to the Insert tab and click on Clip Art. 
2. A Clip Art box will appear on the right of your screen, type a word or sentence that describes the clip art that you 

want. 
3. Click on Go. 
4. In the list of the Clip Arts, double click on the Clip Art that you want to insert in the document. 
Insert Picture from File: Insert the picture saved in your hard disk in your computer by using below given steps: 
1. Click where you want to insert the picture or image in the document.

Fig. 5.2.18 Inserting different types of 
shapes

Fig. 5.2.19 Text box

Fig. 5.2.20 Clip Art
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5. On the Insert tab, in the Illustrations group, click Picture. 
6. Locate the picture that you want to insert. For example, you might have a picture file located in My Documents. 
7. Double-click the picture that you want to insert and it will appear in your document. 

5.2.9 Tables
Tables can be used to create lists or format text in an organised manner in any word document.
Inserting a Table in your document
1. Click on the area where you want to insert a table. 
2. In the Tables group, go to the Insert tab and click on Table.

3. You will see a drop down box; click and hold your mouse button and then 
drag it to the selected number of rows and columns that you want inserted. 
You will see a table appear in the document as you drag on the grid. 

4. Once you have highlighted the rows and columns for the table that you  
want, leave your mouse and the table will be inserted in the document. 

Adding a Row or a Column in a Table 
1. Click on the table where you want to add a row or a column.
2. Go to the Layout tab under Table Tools.
3. You need to click on Insert Left or Insert Right to insert a column and click 

on the Insert Above or Insert Below for adding a row. 
4. You need to click on Delete to remove a row, column or cell.  
Deleting a Table 
1. Place the pointer on the table until the table move icon appears and then 

move wherever required by moving the icon.
2. Press Backspace on the keyboard. 
Deleting Content in Tables
If you want to delete only the content of a cell, a row, a column and the complete table, you can delete it by clicking 
on clear content. The rows and columns of the table will remain the same even after you delete the contents of table.

Fig. 5.2.21 Inserting table

Fig. 5.2.22 Table editing
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5.2.10 Headers, Footers and Page Numbers 
Headers, footers and page numbers can be added by using various methods. 
The easiest way is to double click on the top or bottom of the page and the 
header and footer area will appear. You can enter the text you wish to be 
displayed at the top or bottom of every page in the document.
Adding Page Numbers 

If you want a page number on each page in the file by following the below steps: 
1. In the Header & Footer group, go to the Insert tab and click on Page Number. 
2. Click the page number in the location that you require.
3. Scroll through the options which are available and then click the page number 

format that you want to use. 
4. To return to the body of your document, click anywhere on the page.
5. Close Header and Footer section.

Fig. 5.2.23 Header and footer

Fig. 5.2.24 Edit page number

Adding Header or a Footer 
1. In the Header & Footer section, go to the Insert tab and click on Header or Footer. 
2. Click Header or Footer that you want to add and your header or footer area will open in the file. 
3. Type the required text in the header or footer area. 
4. To return to the body of your document, click anywhere on the page. 
Removing the Page Numbers, Headers or Footers 
1. Click on the Header, Footer or Page Number Command in the file.
2. A drop down menu will appear on the screen.
3. At the bottom of the menu, click Remove in the file.

Fig. 5.2.25 Close header and footer Fig. 5.2.26 Header and footer
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5.2.11 Finalising a Document
Using the "Spell Check" Feature 
If any word is spelled incorrectly a red wavy line will appear under that 
word. The fastest way to fix spelling errors is to: 
1. Put your cursor over the misspelled word and right click. 
2. A drop down box will appear with correct spellings of the word. 

1. The Print tab is the place to go to make sure you are printing what you want. 
2. Click the File tab. 
3. Click the Print command to print a document. 
This dropdown shows the currently selected printer. Clicking the dropdown will display other available printers. 
These dropdown menus show currently selected Settings. Rather than just showing you the name of a feature, these 
dropdown menus show you what the status of a feature is and describes it. This can help you figure out if you want to 
change the setting from what you have. 

3. Highlight and left click the word you want to replace the incorrect word with. 
You can also use the spelling and grammar feature in order to complete a more comprehensive spelling and grammar 
check

1. Click on the Review tab 
2. Click on the Spelling & Grammar command (a blue check mark with ABC above it). 
3. A Spelling and Grammar box will appear. 

4. You can correct any Spelling or Grammar issue within the box. 
Print Preview 

Print Preview automatically displays when you click on the Print tab. Whenever you make a change to a print-related 
setting, the preview is automatically updated. 
1. Click the File tab, and then click Print. To go back to your document, click the File tab. 
2. A preview of your document automatically appears. To view each page, click the arrows below the preview. 
Print 

Fig. 5.2.27 Spell check
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Save a Document 

To save a document in the format used by Word, do the following: 
1. Click the File tab. 
2. Click Save As. 

3. In the File name box, enter a name for your document. 
4. Click Save. 

1. Write a leave application, addressing your trainer with the following specifications:
a. Bold and italicise the subject.
b. Bold the date.
c. The letter should be justified
d. Font: Calibri
e. Font size: 12

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Practical

Fig. 5.2.29 Save a document

Fig. 5.2.28 Print preview
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1. Which tab contains the Bold, Italic and Underline options?
a. Home 
b. Insert
c. View
d. Review

2. Ctrl+V command is used to:
a. Copy
b. Paste 
c. Cut

d. Print
3. Save As command is available in:

a. File tab
b. Home tab
c. Insert tab
d. None of these

Exercise
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________



Participant Handbook

89

Customer Care Executive (Call Centre)Customer Care Executive (Call Centre)

5.3.1 Microsoft Excel 

5.3.2 The Ribbon 

MS Excel is a spreadsheet application in the Microsoft 
Office Suite. Excel allows you to store, manipulate 
and analyse data in organised workbooks for home 
and business tasks. MS Excel has many additional 
features and tools that are not available in MS Word. 
These are all described in this lesson.

The ribbon contains all of the commands that is needed to do common tasks. It has multiple tabs, each with several 
groups of commands, and you can add your own tabs that contain your favourite commands. 

UNIT 5.3: Microsoft Excel 

At the end of this unit, you will be able to: 
1. Understand the use of MS Excel 

Unit Objectives

Fig. 5.3.1 MS Excel

Fig. 5.3.2 Ribbon
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Tabs available in MS Excel
Home Tab: Home tab consists of text formatting features like font size, font style, paragraph changes etc. It also 
comprises of spreadsheet formatting elements such as text wrap, merging cells and cell style.

Insert Tab: Through this tab on can get an access to insert variety of items such as tables, pictures, header footer, clip 
art etc.

Page Layout Tab: This tab allows you to access various features like adjusting page margins, page orientation, page 
background, inserting columns etc.

Formulas Tab: This tab has commands to use when creating Formulas. It consists of an immense function library which 
can assist when creating any formula or function in your spreadsheet.

Data Tab: Data tab helps in modification of worksheets with large amount of data by using features like sorting and 
filtering. It also helps in analysing and grouping data. 

Review Tab: With the help of this tab you can review your document and rectify spelling and grammar issues. It also 
consists of track changes features which helps to identify the changes made in a document.

Fig. 5.3.3 Home tab

Fig. 5.3.4 Insert tab

Fig. 5.3.5 Page layout tab

Fig. 5.3.6 Formulas tab

Fig. 5.3.7 Data tab
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View Tab: This tab allows you to view your document the way you want. For example if you want to view the document 
by using zoom feature you can view it.

5.3.3 Components in the Workbook

Name Box

The Name box provides you with the location or the “name” of a selected 
cell. In the image below, cell B4 is in the Name box. Note cell B4 is where 
column B and row 4 intersect.

Formula Bar
Formula bar is basically used to enter or edit data, a 
formula, or a function that will appear in a specific cell. In 
the image below, cell C1 is selected and 1984 is entered 
into the formula bar. Note how the data appears in both 
the formula bar and in cell C1.

Row

A row is a group of cells that runs from the left of the page 
to the right. In Excel, rows are identified by numbers. Row 
15 is selected in the image below.
 

Column

A column is a group of cells that runs from the top of the 
page to the bottom. In Excel, columns are identified by 
letters. Column L is selected in the image below.

Fig. 5.3.8 Review tab

Fig. 5.3.9 View tab

Fig. 5.3.10 Name box

Fig. 5.3.11 Formula bar

Fig. 5.3.12 Row

Fig. 5.3.13 Column
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Worksheets

Excel files are called workbooks. Each workbook holds one or more 
worksheets or spreadsheets.
Three worksheets appear by default when you open an Excel workbook 
in your computer. You can rename, add or delete worksheets as per 
your need. 
 

5.3.4 Getting Started 
Let us have a look at the steps needed to create an 
Excel document.
Opening Excel
On your desktop you may have a shortcut to Excel, 
if so double click the icon to open Excel. Otherwise 
follow the below given steps: 
1. Click on the Start button of your computer
2. Highlight Programs 
3. Highlight Microsoft Office 
4. Click on Microsoft Excel 

Create a New Workbook 

1. Go to the File tab and then click New. 
2. Under Templates section, double click on the Blank Workbook or Click on Create. 
Find and Apply Template 
Excel allows you to apply built-in templates. To find a template in Excel, follow the below steps: 
1. On the File tab, click on New. 
2. Do either of the following: 

 ● In order to reuse a template that you’ve recently used, click Recent Templates and select the required file. 
 ● If you want to use use your own template, click on My Templates and select the template that you want to 

use and then click on OK. 
3. Click on the template that you like, and it will open on your screen as a new document which you can work on.

5.3.5 Enter Data in a Worksheet 
In this section, we will learn how to select cells, insert content and delete cells.

Fig. 5.3.14 Worksheets

Fig. 5.3.15 Starting with excel
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The cell
The rectangle boxes in a worksheet are called cells. The intersection of 
row or column is called cell. Each cell has a name, or a cell address based 
on which column and row it intersects. The cell address of a selected cell 
appears in the Name box of your document. Here you can see that B3 cell 
is selected.

Cell content

Each cell can contain its own formatting, text, formulas, comments and 
functions.

1. For selection of a cell, click on it.
2. By using keyboard enter content into the selected cell. The 

content appears in the formula bar and cell. 
To delete content within cells:
1. Select the cells that you want to delete.
2. On the ribbon, click the clear command. A dialog box will appear 

on the screen.
3. At last select clear content.
By using keyboard's backspace butto, you can delete content from 
the multiple cells or single cell
To delete cells:
1. Select the cells that you want to delete.
2. On the ribbon, choose the delete command.

 ● Text: Cells can contain numbers, letters and dates.
 ● Formatting attributes: Cells can contain formatting attributes that change the numbers, way letters and dates. For 

example, dates can be formatted as DD/MM/YYYY or MM/DD/YYYY
 ● Comments: Cells can contain comments from multiple reviewers.
 ● Formulas and functions: Cells can contain functions and formulas that calculate cell values. For example, SUM(cell 

1, cell 2...) formula is used to add the values in multiple cells.
To insert content:

Fig. 5.3.16 Cell

Fig. 5.3.17 Inserting content in a cell

Fig. 5.3.18 Deleting content from a cell

Fig. 5.3.19 Deleting the cell
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5.3.6 Cut, Copy and Paste Data 

5.3.7 Column Width and Row Height 

For moving or copying the cell or their content, you need to use the Cut, 
Copy, and Paste commands. 
Moving or Copying Cells 

When you move or copy a cell, Excel moves or copies the entire cell, 
including formulas and their resulting values, cell formats, and comments. 
1. Select the cells that you want to move or copy. 
2. On the Home tab, in the Clipboard group, do the following: 

 ● Click Cut for moving cells
 ● Click Copy for copying cells

3. Click in the centre of the cell where you want to Paste the information.
4. In the Clipboard group, on the Home tab, click on Paste. 

In this section, we will learn how to set column width and row height. 
Set Column’s/Row’s Width/Height 
1. Select the column(s) or row(s) that you want to change. 
2. In the Cells group, on the Home tab, click on Format. 
3. Under Cell Size, choose Column Width or Row Height. 
4. You will see a Column Width or Row Height box. 
5. Type the required value in the Column Width or Row Height.
Automatically Fit Column/Row Contents 
6. Click the Select All button
7. Double click on the corner of the cells between two column/row 

headings. 
8. All Columns/Rows in the entire worksheet will get changed to the new size. 

Set Column/Row Width/Height with Mouse 
1. Place your cursor on the line between two rows or columns. 
2. On the horizontal line a symbol that looks like a lower case ‘t’ with arrows will appear. 

Fig. 5.3.20 Cut, copy and paste data

Fig. 5.3.21 Column width and row height

Fig. 5.3.22 Setting of column width Fig. 5.3.23 Setting of row height
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5.3.8 Merge or Split Cells 

3. Drag the boundary on the right side of the column/row heading until the 
column/row is the width that you require.

To change the width of multiple columns/rows:
1. Select the columns/rows that you want to change. 
2. Drag a boundary to the right of a selected column/row heading. 
3. All selected columns/rows will become of a different size.
To change the width of columns/rows to fit contents in the cells:
1. Select the column(s) or row(s) that you want to change. 
2. Double-click the boundary to the right of a selected column/row heading. 
3. The Column/Row will automatically resize to the length/height of the longest/ 

tallest text.

A cell becomes one large cell if you merge two or more than two adjacent horizontal or vertical cell. When you merge 
cells, the contents one of the cell appears in the merged cell. 
Merge and Centre Cells 

1. Select two or more adjacent cells that you would like  to 
merge. 

2. In the Alignment group, on the Home tab, click Merge and 
Centre. 

3. The cells will get merged in a column or row and the 

contents of the cells  will be centred in the merged cell. 

Merge Cells 

Click the arrow next to Merge and Centre to merge cells and then click on 

Merge Across or Merge Cells. 

Split Cells 

1. Select the merged cell you would like to split.
2. Click Merge and Centre to split the merged cell. The cells will split and the 

contents of the merged cell will appear in the upper left cell of the split 
cells. 

Fig. 5.3.24 Adjusting of column/row 
content

Fig. 5.3.25 Merge and centre cells

Fig. 5.3.26 Merge cells
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5.3.9 Formatting Spreadsheets 
You can format a number of elements such as text, numbers, colouring and table styles in order to enhace your 
spreadsheet. Spreadsheets can become professional documents used for company meetings or even publishing.

Wrap Text 
If you wrap a text in a cell you can display multiple lines of text          
inside it. 
1. Click the cell in which you would like to wrap the text. 
2. In the Alignment section, on the Home tab and click Wrap Text. 
3. The text in your cell will get wrapped. 
Format Numbers 
In Excel, the format of a cell is separate from the data which  is stored in the specific cell. This display difference can 
have a significant effect in numeric data. After typing numbers in a cell, you can change the format in which they are 
displayed to ensure the numbers in your spreadsheet are displayed as you required.
1. Click the cells that has the numbers that you want to be formated.
2. In the Number group, on the Home tab, click the arrow next to the Number Format box and then click the format 

that you require.
Cell Borders 

Border can be added around a cell by using predefined border styles in the options given. You can also create a 
customised borders as per your requirements.
Apply Cell Borders: 

1. On an excel sheet, select the cell or range of cells that you want to add a border, change the border style or remove 
a border. 

Fig. 5.3.27 Wrap text

Fig. 5.3.28 Format cell
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2. In the Font group, go to the Home tab
3. Click the arrow adjuscent to Borders 
4. Click on the border style you would like have
5. The required border will be applied 
Remove Cell Borders:

1. In the Font group, go to the Home tab
2. Click the arrow next to the Borders

3. Click No Border to remove cell border

Cell Fill: 
1. Select the cells that you want to apply or remove a colour.
2. In the Font group, go to the Home tab and select either of the following options: 

 ● Click the arrow next to Fill Colour to fill cells with a solid colour and then under 
Theme Colours or Standard Colours, click on the colour that you need. 

 ● Click the arrow next to Fill Colour to fill cells with a custom colour, click More 
Colours, and then in the Colours dialog box select the colour that you need. 

 ● Click Fill Colour to fill the most recently selected colour.
Remove Cell Fill: 
1. A cell that contains a fill colour or fill pattern, Select it.
2. In the Font group, on the Home tab and click the arrow next to Fill Colour 

and then click on No Fill. 
Text Colour 
1. Select the range of cells or cell, text or characters that you would like to 

format with a different text colour. 
2. In the Font group, on the Home tab and select either of the following 

options: 
 ● Click on Font Colour to apply the most recently selected text colour. 
 ● Click the arrow next to Font Colour to change the text colour and then 

under Theme Colours or Standard Colours, click the colour that you 
want to have.

Bold, Underline and Italics Text 

1. Select the cell, range of cells, or text where you would like to Bold, Underline 
and Italics the Text.

Fig. 5.3.29 Cell borders

Fig. 5.3.30 Cell and text colouring
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2. In the Font group, go to the Home tab. 
3. As needed, Click on the Bold (B) Italics (I) or Underline (U) commands. 
4. The selected command will get applied. 

5.3.10 Formulas in Excel 
Formulas are equations that perform calculations on values in your worksheet. A formula always starts with an equal 
sign (=). 
You can also create a formula by using a function which is a prewritten formula that takes a value, performs an operation 
and returns a value. 
Depending on the type of formula that you create, a formula can contain any or all of the following parts: 
1. Functions: A function, such as SUM(), starts with an equal sign (=).
2. Cell references: You can refer to data in worksheet cells by including cell references in the formula. For example, 

the cell reference A2 returns the value of that cell or uses that value in the calculation. 

3. Constants: You can also enter constants, such as numbers (such as 2) or text values, directly into a formula. 
4. Operators: Operators are the symbols that are used to specify the type of calculation that you want the formula 

to perform.

EXAMPLE of FORMULA WHAT IT DOES 
=5+3 Adds 5 and 3 
=5-3 Subtracts 3 from 5 
=5/3 Divides 5 by 3 
=5*3 Multiplies 5 times 3 
=5^3 Raises 5 to the 3rd power 

Use Auto Sum 

To summarise values, you can also use AutoSum. 
1. Select the cell where you would like your formulas to appear. 
2. In the Editing group, go to the Home tab.
3. Click on AutoSum, to add your numbers or click the arrow next to AutoSum to select a function that you would 

like to apply.

Fig. 5.3.31 Bold, underline and italic text 

Fig. 5.3.32 Auto sum 
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5.3.11 Finalising a Spreadsheet 
Below are a few things, you should use to finalized a document: 
Using the "Spell Check" 

To complete a Spelling and Grammar check, you need to use the 
Spelling and Grammar feature. 
1. Click on the Review tab 
2. Click on the Spelling & Grammar command (This is a blue 

check mark with ABC above it). 
3. A Spelling and Grammar box will appear, you can correct any 

Spelling or Grammar issue with the help of this box. 

Saving a Spreadsheet 

To save a document in the format used by Excel, do the following: 
1. Click on the File tab. 
2. Click on Save As. 
3. In the File name box, enter a name of your document. 
4. Click on Save. 

Fig. 5.3.33 Spell check

Print Preview 

Print Preview automatically displays when you click on the Print tab. Whenever 
you make a change to a print-related setting, the preview is automatically 
updated. 
1. Click the File tab, and then click Print. To go back to your document, click 

the File tab. 
2. A preview of your document automatically appears. To view each page, 

click the arrows below the preview. 
Print a Worksheet 

1. Click the worksheet or select the worksheets that you want to print. 
2. Click File 
3. Click Print. 

Fig. 5.3.34 Printing a worksheet

4. Once you are on the Print screen, you can select printing options: 
 ● To change the printer, click the drop-down box under Printer and select the printer that you want. 
 ● To make page setup changes, including changing page orientation, paper size and page margins, select the 

options that you want under Settings. 
 ● To scale the entire worksheet to fit on a single printed page, under Settings, click the option that you want in 

the scale options drop-down box. 
 ● To print the specific information, select Print Active Sheets or Print Entire Workbook. 

5. Click Print.
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1. Create a data sheet as per the specifications given:
a. Name the sheet Class_Details.xls
b. Create a table with column headers as – Roll No., Name, Date of Birth, Qualification, Age
c. Make a chart which depicts no. of students in various age groups.
d. Highlight the name of students with age less than 25.

2. Recreate the following table in excel and calculate the total amount, deposits and balance.

Practical
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1. Tabs that are available in Excel Ribbon:
a. Data pane

b. Formulas pane
c. Page Layout pane
d. All of these

2. Sort option is used to :
a. Sort the data in increasing order

b. Sort the data in decreasing order

c. Animation
d. Transition

3. Chart option is available in:
a. Data tab
b. Home tab
c. Insert tab
d. None of these

Exercise

2 Opening Balance  $ 500.00  $ 500.00 

3 100 4/7/04 Office Supplies  $   78.50  $ 421.50 

4 101 4/7/04 The Phone Store  $ 180.98  $ 240.52 
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A B C D E F

1 Cheque No Date Description  Amount  Deposit  Balance 
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5.4.2 The Internet has Changed Our Lives Completely
Internet is an international network of networks that consists of 
millions of private, public, academic, business, and government 
packet switched networks, linked by a broad array of electronic, 
wireless, and optical networking technologies.
The Internet carries an extensive range of information resources 
and services, such as the inter-linked hypertext documents and 
applications of the World Wide Web (WWW), the infrastructure 
to support email, and peer-topeer networks for file sharing and 
telephony. It is a global system of interconnected computer networks 
that use the standard Internet protocol suite (TCP/IP) to link several 
billion devices worldwide.

Applications of Internet
Work: Internet is used extensively at workplace, in media world is as the most important tools as it keeps them up to 
date with the events and current news.
Social aspects: Internet is also used for social media. Social networking sites such as Twitter and Facebook have 
unlimited users all over the world to communicate with their family and friends. These social websites can be accepted 
on cell phones, so the usage is high. 
Education: Schools also use internet for teaching. Many schools use electronic projector systems where teachers show 
online program in the class room by using huge white board. 
Entertainment: It is with the help of internet that we are able to listen to any music with a click of button. To listen to 
music or watch videos Youtube is used.

5.4.1 Network
A group of two or more computers linked together is known as network. There are many types of computer networks, 
such as:

 ● Local Area Networks (LANs): These computers are in the same building.
 ● Wide Area Networks (WANs): The computers are farther apart and are connected by telephone lines or                            

radio waves.
 ● Metropolitan Area Networks (MANs): This means a data network designed for a city or town.

UNIT 5.4: Internet and Network

At the end of this unit, you will be able to: 
1. Understand the internet and network 

2. Understand the use of different applications of internet 

Unit Objectives

Fig. 5.4.1 Internet
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Note: Railway reservation, online banking, payment of bills and mobile recharge, entertainment and education are the 
most common applications of internet.

What is E-mail?
Electronic mail, most commonly referred to as email or e-mail is a method of exchanging digital messages from one to 
one or one to many. Modern email operates across the Internet or other computer networks.
What is a Web Search Engine?
A web search engine is a software system that is designed to search for information on the World Wide Web. The 
search results are generally presented in a line of results often referred to as search engine results pages (SERPs). The 
information may be a mix of web pages, images, and other types of files. Some search engines also mine data available 
in databases or open directories. Top 5 search engines are: Google, Yahoo, Bing, Ask.com and AOL.

1. Browse the internet using google.com and find the names of the CEOs of any 10 pharmaceutical organisations.

___________________________________________________________________________________________

___________________________________________________________________________________________

2. Write the benefits of Internet.

___________________________________________________________________________________________

___________________________________________________________________________________________

Practical
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2. Full form of www is:
a. Work with work
b. World wide web
c. World wide work
d. World well wisher

3. Which of the following is not a search engine?
a. Google

b. Yahoo
c. Microsoft
d. Bing

1. Different types of network are:
a. LAN
b. WAN
c. MAN
d. All of these

Exercise
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Unit 6.1 – Listening Skills 

Unit 6.2 – Speaking Skills

Unit 6.3 – Reading and Comprehension Skills

Unit 6.4 – Writing Skills

6. Language Skills 

TEL/N0100, TEL/N0101,  
TEL/N0102, TEL/N0103,  

TEL/N0104
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Key Learning Outcomes
At the end of this module, you will be able to:

1.  Understand the importance of listening as a skill for a CCE
2.  Practice effective listening skills
3.  Use effective speaking skills in your role
4.  Demonstrate reading and keep yourself updated on latest news
5.  Practice effective writing skills
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UNIT 6.1: Listening Skills

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept and importance of listening skills for a CCE

6.1.1 Listening Skills
What is listening?

Listening is one of most important skills, but it often gets overlooked. Listening is receiving language through the ears. 
Listening involves identifying the sounds of speech and processing them into words and sentences. Listening means to 
correctly receive messages in the communication process. A good listener will listen not only to what is being said, but 
also to what is left unsaid or only partially said. Listening involves observing body language and noticing inconsistencies 
between verbal and nonverbal messages. In a customer centric job, listening plays an important role.
We listen:

 ● To get information
 ● To understand

 ● To learn

Importance of listening for your job role:
A customer care executive is the first face to whom customers interact with. The motive for a customer to call in call 
centre is to listen to their queries, requests and complaints. So the role of listening is very crucial to your job.
As a Customer Care Executive you should:

 ● Interpret customer’s requirement and suggest related product/offer/scheme.
 ● Respond to customer’s Q R C (Query, Request, Complaint) with a relevant answer.
 ● Gauge customer’s communication style and respond appropriately.
 ● Give clear instructions to customers. 

Guidelines for effective listening 
If you try and follow these guidelines while listening, you will become a better listener.
1. Don’t talk too much
Try to listen more than you talk. Talk to clarify only when the other person has finished speaking.
2. Prime yourself to listen well
Focus fully on the speaker. When in a conversation put other things out of mind.
3. Encourage the speaker
Help the speaker to feel free to speak, in your case it would be the customer. It may also be your colleague or superior. 
Never forget their needs and concerns. Use body language such as other gestures or words to encourage them to 
continue.
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4. Remove Distractions
Focus on what is being said: don’t do other activities such as scribbling on paper, shuffling papers, arranging your desk, 
looking out of the window, etc.
5. Empathise with the speaker
Look at issues from their perspective. Put yourself in the other person’s place and understand their point of view.
6. Be Patient
Don’t try to finish other sentences, give them time to complete their thoughts. Don’t interrupt pauses.
7. Avoid Personal Prejudice
Try to be impartial. Do not get irritated or get biased due to the person’s habits or mannerisms.
8. Listen to the Tone of the Speaker
The volume and tone of voice, both are important and tell us more than the words what the speaker is trying to convey.
9. Non-Verbal Communication
Non-Verbal communication or body language such as Gestures, facial expressions, and eye-movements are very 
important. This will be useful while interacting directly with your friends, colleagues and superiors.
Now let’s see a typical conversation between a CCE and a customer which shows active listening. A customer, Leena 
calls at the Customer Care Centre.
CCE: Good Afternoon! I am Kiran, how can I assist you?
Leena: Good afternoon Kiran. My name is Leena Kapoor.
CCE: Sorry?
Leena: My name is Leena Kapoor
CCE: Your name is Leena Kapoor?
Leena: That’s right a…
CCE: Leena as I can see your VC number which is found on our system is 01501571890, is it right?
Leena: That’s right.
CCE: Ms. Leena, as I can see, this connection is on your name and your mobile number which we have is 9800012345, 
is it right?
Leena: That’s right.
CCE: And your e-mail id is name@hotmail.com, is it right?
Leena: That’s right.
CCE: Thank you for giving us information. Sorry for the inconvenience. Ms. Leena, how can I assist you?
Leena: Just wanted to check with you about my M Tariff Plan, the date for deactivation is 23 February, when do I have 
to reactivate my plan?
<Pause for 2 seconds>
CCE: Sorry?
Leena: When should I reactivate my tariff plan meaning to say…recharge my SIM?
CCE: Alright, you are asking for tariff recharge plan.
Leena: That’s right!
CCE: Am I right?
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1. What are the three objectives of effective listening?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

A work related conversation - The talker is the customer and the listener is a salesman. The talker explains his needs 
and requirements without explicitly stating which product or service he is interested in.

 ● You are allocated 5 minute for the conversation- the listener should listen attentively to the talker and exhibit active 
listening and at the end provide the solution.
__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

Practical

Notes
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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Leena: Yeah! Yeah! That’s right!
CCE: Your next recharge date is 25 March 2014.
Leena: OK. Alright! Thank you so… much! Bye.
CCE: Ms. Leena you can check on your package due date either from SMS or my Plan M on net also. I am sorry for the 
inconvenience. Ms. Leena, you want any further information from my side?
Leena: No, thank you very much Kiran, thank you.
CCE: Welcome. Ms. Leena, thank you for calling ABC customer care centre. Have a nice day!
Leena: Thank you, bye!
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UNIT 6.2: Speaking Skills

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the concept and importance of speaking skills

6.2.1 Speaking Skills

What is speaking?
Speaking is an interactive process in constructing meaning that involves producing, receiving, and processing 
information orally. 
Importance of speaking for your job role:
As a Customer Care Executive, it is very important to be effective at speaking. So, how you speak to the customers 
creates an image in the mind of the customer. So you have to speak effectively. Practice is the key for effective speaking. 
All the good speakers and successful people practice a lot before speaking. If the listener doesn’t understand what you 
are saying, the speaking skills are of no use.
As a Customer Care Executive you should:

 ● Be Prepared
 ● Know your content well
 ● Use a simple language

 ● Use examples. The customers will understand when you use examples
 ● Be aware of your body language so that it shows in your voice
 ● Discuss self-performance criteria with the supervisor
 ● Probe customers appropriately to understand nature of problem
 ● Avoid using jargons, slang, technical terms and acronyms when communicating with customers
 ● Clearly communicate with peers/seniors during morning brief

Components of Speaking Skills
The important components of speaking skills are:

 ● Tone         

 ● Comprehension

 ● Grammar

 ● Vocabulary
 ● Pronunciation 
 ● Fluency
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 ● Body language 
 ● Rate of Speech 

Tone
Tone involves the volume you use, the level and type of emotion that you communicate and the emphasis that you 
place on the words that you choose. If you speak with lack of energy and in a monotonous tone, then certainly the 
customer will get bored.
Comprehension

For oral communication, it certainly requires a subject to respond, to speech as well as to initiate it.
Grammar

It is needed that you arrange a correct sentence in conversation. Grammer helps to learn the correct way of expresing 
a language in both oral and written form.
Vocabulary

Without vocabulary nothing can be conveyed. So, without mastering vocabulary sufficiently in English you will not 
be able to speak English or write English properly. Vocabulary means knowing many different words in a particular 
language.
Pronunciation
Pronunciation is the way to produce clearer language when you speak. It deals with the phonological process that 
refers to the component of a grammar made up of the elements and principles that determine how sounds vary and 
pattern in a language. Pronunciation is the knowledge of studying about how the words in a particular language are 
produced clearly when people speak. In speaking, pronunciation plays a vital role in order to make the process of 
communication easy to understand.
Fluency
Fluency can be defined as the ability to speak fluently and accurately. Fluency means speaking at a normal speed 
without hesitation, repetition and self-correction. To be fluent it’s important, that you don’t use fillers like “you know”, 
“I mean”,“ums”, “ers”,“aaahhhh”, etc. 
Body language

Body language means communicating through body posture, gestures, facial expressions and tone of voice. Body 
language must be in sync with your words; otherwise it is likely to confuse the customers. Positive body language is 
important in supporting your words and ensuring that your message is understood correctly.
Rate of Speech
A slow rate of speech makes the conversation disinteresting. Speak at a moderate pace and with appropriate volume. 
An executive should match his rate of speech with that of the customer.

1. Why is body language important for a CCE?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise
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I, Me, Myself
 ● Get divided in pairs.
 ● One person out of each pair has to talk for 2 minutes non-stop about whatever subject they like, however they are 

not allowed to use the words; I, me, myself, mine or my.
 ● Both speaker and listening party are not allowed to ask any questions.
 ● The listener is not allowed to show any facial expressions such as nodding, shaking their head, smiling or frowning.
 ● Every time the speaker mentions any of the forbidden words above, the other person should draw a cross on a 

paper.

Pick a topic

 ● Every one has to speak up for one minute on that topic. When you speak up, you must first summarise the previous 
person’s views before providing your own inputs. However, in this round if anyone makes a mistake and skips this 
summary, he is forced to drop out for the remainder of the discussion. Continue until you have only two people 
talking or till the topic has been exhausted.

2. Write any five components of speaking.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Practical

Notes
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UNIT 6.3:  Reading and Comprehension Skills

Unit Objectives
At the end of this unit, you will be able to:
1. Understand the concept and importance of reading and comprehension skills.

6.3.1 Reading Skills

What is Reading?

Reading refers to the specific abilities that enable a person to read with independence and interact with the message. 

Importance of Reading Skills:
Good reading skills help you to comprehend ideas, follow arguments, and detect implications. You can extract from 
the writing what is important for the particular task you are employed in. As a customer care executive, you need to:

 ● Read data related tariffs, offers and schemes. 
 ● Read daily, weekly and monthly reports. 
 ● Analyse and comprehend daily, weekly and monthly reports, to monitor performance. 
 ● Read about new products and services with reference to the organization through the intranet portal.
 ● Keep abreast with the latest knowledge by reading brochures and pamphlets. 

Techniques for good reading skills:
Given below are three techniques for effective reading:

 ● Scanning

 ● Skimming

 ● Reading for Detail
Scanning:

Scanning is used when you need to look for a specific piece of information in a given text. For scanning, look over the 
selection quickly to locate the particular piece of information you need and read only that information, but carefully. 
Once you find the required information, stop reading. Scanning is a fast form of reading that does not pay attention to 
every detail given in the text. 
Skimming:

Skimming, is also a quick type of reading. In skimming, we try to learn the main points in a selection of writing rather 
than answer one specific question. When you skim a reading passage, we should be able to pull out the most essential 
information. The most straight forward way to skim a given piece is to read the full first paragraph, the full last 
paragraph and read the first sentence of each additional paragraph in between. This will help you identify the theme 
of the passage.
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Reading for Detail:
Careful reading or reading for detail is how we mostly read. Here we begin at the start  of a passage and proceed to the 
end. In reading for detail, one should read every word, every sentence.

Practice reading these 2 passages and then answer the questions given below:
Passage 1

The ICT (Information and Communication Technology) industry remains one of the most vibrant and dynamic global 
markets; as more and more people are getting connected, new applications and services are being developed and users’ 
online experiences are expanding throughout the world. Living in a networked society certainly brings a host of exciting 
prospects, but also raises questions about how new technologies and services can best be used to achieve society’s 
goals. In this increasingly digital environment, some key questions need to be addressed to assess the readiness of 
countries’ legal and regulatory frameworks and assist policy-makers and regulators in pushing forward their national 
digital agendas within the context of a globalized, connected world.
Questions:

a) What is ICT industry all about?

___________________________________________________________________________________________

___________________________________________________________________________________________

b) Why ICT industry is still one of the most vibrant and dynamic global market?

___________________________________________________________________________________________

___________________________________________________________________________________________

c) What are the pros and cons of living in a highly networked society?

___________________________________________________________________________________________

___________________________________________________________________________________________

d) Who are responsible for addressing the key questions related to Telecommunication industry?

___________________________________________________________________________________________

___________________________________________________________________________________________

Passage 2

No other industry touches as many technology-related business sectors as telecommunications, which, by definition, 
encompasses not only the traditional areas of local and long-distance telephone service, but also advanced technology-
based services including wireless communications, the Internet, fiber-optics and satellites. Telecom is also deeply 
intertwined with entertainment of all types. Cable TV systems, such as Comcast, are aggressively offering local 
telephone service and high-speed Internet access. The relationship between the telecom and cable sectors has become 
even more complex as traditional telecommunications firms such as AT&T are selling television via the Internet, and 
competing directly against cable for consumers’ entertainment dollars. (Source: https://www.plunkettresearch.com/
industries/telecommunications-market-research/)
Questions

a) Which industry touches technology business at a high rate?

___________________________________________________________________________________________

___________________________________________________________________________________________
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1. Write the three techniques of effective reading.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. Write three ways in which you could skim while reading.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

Notes
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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b) What is the definition of telecommunication?

___________________________________________________________________________________________

___________________________________________________________________________________________

c) What is Cable TV system offering?

___________________________________________________________________________________________

___________________________________________________________________________________________

d) What are the advanced technologies based services?

___________________________________________________________________________________________

___________________________________________________________________________________________

e) Why relation between telecom and cable sectors has become complex?

___________________________________________________________________________________________

___________________________________________________________________________________________
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UNIT 6.4: Writing Skills

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept and importance of writing skills.

6.4.1 Writing Skills
What is Writing?
Writing is a medium of communication that represents language through the inscription of signs and symbols.
Importance of Writing Skills
As a Call Centre Executive you will use your writing skills to write mails, reports and communicate effectively at 
work. As a CCE, it’s very crucial to have effective writing skills because often you will communicate with others in 
the organization through mails or written reports. For a brief writing style, omit needless words, combine sentences 
wherever necessary and reframe the sentences in the best possible way.
For example: Instead of saying, “Our main objective is to increase sales. Specifically, the objective is to double the sales 
in the next five years by becoming a more successful business.” you can say, “Our objective is to double the sales in 
the next five years.”
As a customer care executive, you should:

 ● Plan, organize, and write and assemble all useful information.
 ● Determine what’s important and choose what to leave out.
 ● Group the information logically and record complete and correct customer discussions in CRM/MS Excel. 
 ● Formulate correct sentences without any grammatical errors and record precise and clear information for analysis/

action by other departments. 

1. Why is writing skill so important for a CCE?

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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Key Learning Outcomes
At the end of this module, you will be able to:

1.  Understand the concept of inbound and outbound calls
2.  Demonstrate how to attend and make calls effectively

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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7.1.1 Inbound and Outbound Calls
Inbound Calls

Inbound calls, are calls that are routed into the call centre. This basically means that the agent does not call “outside” 
the call centre, but answers call directly from customers who call the given phone number. An example of this would 
be a person calling a call centre to ask for bill information. The agent answers the call, but does not have to call the 
person directly.

Outbound Calls
Outbound calls, are calls that are routed from the call centre to a home or office. The agent is provided with a list of 
random phone numbers and must call those numbers to offer a service or try to sell something. An example of this 
would be telemarketers who call a private home to sell insurance.

1. What is an inbound call?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. What is an outbound call?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

UNIT 7.1: Introduction

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of Inbound and Outbound Calls

Exercise

Notes
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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UNIT 7.2: Attend and Make Calls

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of attend and make calls

7.2.1 How to Open Calls
 ● Always start the call with a smile – the customer will notice this in your voice.
 ● Greet the customer with greeting for example Good morning/evening/afternoon.
 ● Switch to customer preferred language for e.g., in case after greeting the customer starts speaking in Hindi, CCE 

should speak in customer’s language.
How to make Outbound Calls
A CCE make outbound calls to customers for different reasons. There are two main types of outbound calls: 

 ● Call an existing customer. 
 ● Cold call to a potential customer to inform them about goods and services provided by the company. This is also 

known as Telemarketing. 
Guidelines for Outbond Calling
Outbound calling has three main elements- preparation, planning and purpose.
1. Purpose: to know clearly the purpose or objective of the call.
2. Preparation:

 ● Become alert and ready to focus on the call. 
 ● Adjust your headset to suit your requirements. 
 ● keep a pen and paper ready to take notes as you talk.
 ● Pull out the customer’s name, contact number (found in lead sheets or the database).

3. Planning: When planning an outbound call CCE should have a few: 
 ● A greeting = “Good morning/afternoon!”
 ● Introducing the agent = “Your first name”.
 ● Introducing the company = “ABC Services” 
 ● An opening statement of or question to make sure that the customer is available to talk = “Is this a convenient time 

to talk?” 
For example, “Good morning Sir! This is Nisha calling from the ABC Services. May I speak to you regarding your water 
purifier for a minute.
You must continue only when the customer has given permission 
1. Purpose of the call: Explain the purpose of the call - why the customer is being called and what it is hoped to achieve. 
Make sure that the customer confirms that they understand the purpose of the call.

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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7.2.2 How to Answer Calls

 ● Answer the call before the third ring.
 ● Greet the customer using standard greetings. Don’t say Hello.
 ● Listen. Do not interrupt a caller or become impatient.
 ● Speak clearly and use professional language.
 ● Place a call on hold, if necessary, rather than leaving a phone with an open line. 
 ● Respond promptly to customer.

Hold Procedure 

CCE should put the customer on hold only if it is necessary and remember following things before putting customer 
on hold:

 ● Ask the caller’s permission to be placed on hold.
 ● Provide a timeframe for how long the customer may be on hold.
 ● Give the reason for putting them on hold.

For e.g. “May I place you on hold for about 2 minutes while I do a quick research on this issue?”

“Mr. XYZ, may I please put you on hold for a minute or two to look into the details of your account?”

When you’re back:
 ● Thank them for holding and resume the conversation.

For Example:
 ● Mr. XYZ, thank you for patiently waiting.
 ● Thank You for being on hold Mr. XYZ.

Following Script
1. Do not follow the script word to word, instead try to understand the problem first and tell the content in your own 

words.
2. Talk to the customer in that language in which he/she is comfortable and not in the language, you have learnt it.
3. The understanding or script is comparatively important in addition to remembering it.
Ending Call
1. Once the customer’s query is solved, do not finish the call abruptly. At the end, thank the customer for calling and 

say “You were talking to XYZ, thank you for giving your important time. Have a good day.”

7.2.3 Call Flow for Inbound Calls
Parameter Standard Verbiages 

Opening Good morning/afternoon/evening, Company name, this is agent 
name, how can I help/assist you? 

Identification 1. Sir/ ma'am, do you want information of the same no. you are 
calling from?

2. May I have your full name please?
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Hold <Customer name>, please be on line as I get this information 
checked. 

Unhold <Customer name>, thank you for your patience. 
Refresh Hold It will take some more time to get this information checked ,may I 

place your call on hold for some more time?
Security Check <Customer name>, for security verifications/purposes may I know 

<Sec 1>, <Sec 2>, <Sec 3>? 
Closing <Customer name>, thank you for calling ABC services. 

Fig. 7.2.1 Call flow for inbound calls

Call Opening

Listen to the customer

Identification

Paraphrase and Probing

Classify into query, 
Request and complaint

Query

Provide the resolution
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1. State True or False                                                            

a) The duration of the estimated hold time during a call should be the minimum.

b) After putting a customer on hold you may take as much time as you want before getting back on to the call.

c) To complete a call in the minimum call login time you can skip the greeting part for the customer and directly  
 start with the actual work. 

d) It is the responsibility of the customer care executive to take care of the language capabilities of the   
 customers while talking to them.  

2. The call login time involves:                                   

a) Taking calls                                                                     

b) Taking calls, holding time and wrapping up

c) Both a and b

d) All of these    

3. What is the full form of AHT?                                       

a) After Hold Time

b) Average Handling Time

c) Both a and b

d) None of these

4. While resuming hold,  _____________________  the customer  and appreciate his patience for being on the line.

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

 ______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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Key Learning Outcomes
At the end of this module, you will be able to:

1.  Identify and address customer Query/Request/Complaint (QRC)
2.  Know how to escalate customer QRC as necessary
3.  Know verification parameters to verify customer details 

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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8.1.1 Introduction

8.1.2 Types of Calls at Call Centre

8.1.3 Meaning of Query

Call centre executives respond to questions and inquiries about products or services and handle and resolve complaints. 
All centre agents are the first point of contact between the company and the customer. As such they serve an important 
public relations role i.e. of representing the company to the customer.

In this chapter we will learn different types of calls at call centre and how to handle those calls.

Types of Calls at Call Centre

There are mainly three types of calls at call centre:
 ● Query
 ● Request
 ● Complaint

Query is a question or an inquiry. Through a Query, customer tries taking information about our services or his account.

General Queries at Call centre 

Here are general queries at call centre of  customers:
 ● Balance /Billing enquiries   
 ● Account Related 
 ● New products or services  
 ● VAS related
 ● Tariffs and recharge related

UNIT 8.1: Introduction

Unit Objectives
At the end of this unit, you will be able to: 
1. Introduce different types of calls made by customers in a call centre
2. Introduce type of Query calls at a call centre
3. Understand the concept of Resolutions and Complaints

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Customer complaint can be a query as per the final resolution, for e.g.

1. Customer calls to tell that he is not able to make a call– this is a complaint. Agent checks that 
customer has insufficient balance and informs the same to the customer. Customer says OK and 
ends the call. On the basis of the resolution it is a Query.

2. Customer calls and complaints that MMS is not working. Agent probes and finds out that 
customer does not have settings. Agent gives customer the information on how to get settings 
etc. and customer ends the call. Hence  this is  a Query and not a Complaint.

Therefore, agent should tag query of the customer and the resolution given to the customer in CRM.

8.1.4 SIM/PIN/PUK related information
A PIN is the Personal Identification Number configured for your SIM card . This is a 4-digit number that you can set up 
on your SIM card. Each time when customer switch on his handset, there will be a request to enter the PIN. If the PIN 
is entered wrongly 3 times, customer will get a request for a PUK code, which is the Personal Unlock Key. 

The PUK can be obtained from the Customer Care. If the PUK is entered wrongly 10 times, the SIM gets block and will 
have to be replaced at a nominal charge.

The balance & validity along with other services will remain as it was earlier after SIM replacement.

Customer can retain their old contacts if backup of the contacts has been created. However, in case of lost SIM cards, 
contacts cannot be retained.

8.1.5 Customer Request
Through a request, customer makes a request for a product or a service.

Types of Request 
 ● Request Open
 ● Request Self Closed

Example of Request-Open

Customer calls at call centre and requests the CCE to change his tariff plan. Agent informs the 
customer that it will be changed from the next billing cycle and tagged it as request in open option 
as agent doesn’t have rights to change tariff plan from his own end.
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Request Open
In this, the agent will have to take an action together with providing information.

For e.g. Activation/Deactivation of a Service which can be only processed through backend.

Request Self Close 
In this, the agent will take an online action together with providing information

For e.g.

1. Instant deactivation of a service through vendor link

2. Instant  activation of a service through vendor link

Example of Request-Self Closed

Customer calls at call centre and asks the CCE that he wants to deactivate caller tune in his number. 
Agent deactivated the same from his system and informs the customer. Here agent has rights to 
deactivate caller tune so he tagged it as Request-Self Closed.

8.1.6 Customer Complaint and Resolution
In a  complaint customer is complaining against services as he is facing some issue. 

Complaint-Open 

Agent registers complaint as 'Open' in following scenarios 

1. Gap in Service 

2. Gap in Product

3. Gap in Process

4. Validated Disputes 

5. Benefits not received 

Open Complaints can be resolved by backend team only.

Complaint-Self Closed
Agent should self close a complaint in the following scenarios: 

1. Online Waver 

In this CCE has some limits wherein he can give waiver to the customer. For example customer refuses to pay penalty 
for delay in payment as he got the bill on due date. CCE can give waiver to the customer and close the complaint.

2. Planned Downtime 

In case CCE is aware that there is a planned downtime in the region and network team is restoring the site and if a 
customer is calling from the same region he can inform the customer and close the complaint.

3. Known issue of benefits not received

For example, in one of the recharge promos, customer is supposed to get Rs. 50 extra on recharge of Rs. 500. However,  
customer complains that hé has not received any benefits on recharge of Rs. 500. As  per backend communication, all 
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customers who recharged under recharge promo have not  got  benefits, and all benefits will be credited in one week. 
So CCE can close the complaint and inform the customer about TAT.

4. Known Disruption in Service

For example, there is a communication that customers who will use 3G services may face problem in late hours due 
to some technical problem and it will be rectified in a week. So if a customer complaints regarding the problem in 3G 
services at late hours, then CCE can inform the customer and close the complaint. 

Handling Customer Complaints 

Here are a few tips to handle customer complaints:
 ● Listen to the customer
 ● Paraphrase the issue
 ● Apologise to the concern
 ● Acknowledge the customer
 ● Explain the action taken to resolve customer concern
 ● Thank the customer

 ● Even if customer is abusing you or is angry on you, remember customer is facing some issue because of which he 
is behaving like this so do not  take it personally

 ● Remain calm throughout the interaction
 ● Focus on the problem not person
 ● “Turn Unhappy Person into Happy Customer”

1. True/False

a) All requests can be self-closed by CCE. True or False?

b) CCE should tag as complaint if customer wants to activate his MMS services. True or False?

2. When an irate customer calls at call centre for complaint CCE should

a) Empathise with him/her, then ask them to hold and get a supervisor to handle the caller

b) Ask question

c) Hang up

3. Identify whether it is a complaint, request or a query.

a) A customer is facing some problem in his network. 

b) Customer wants to know the latest scheme. 

c) Customer wants to change his caller tune. 

d) Customer is angry. He says that he did not activate any caller tune for which Rs. 30 have been deducted from 
his balance. 

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
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1. One participant becomes a customer who has to inquire about a monthly rental plan. The CCE has to know the 
requirements of the customer and then suggest a plan accordingly. The customer will then request the CCE to 
change his plan. 

______________________________________________________________________________________________

______________________________________________________________________________________________

2. All the other participants have to observe and record/document the conversation of the customer and the CCE. 

______________________________________________________________________________________________

______________________________________________________________________________________________

4. Narrate any instance wherein you called at any call centre for enquiry. Explain the entire conversation with CCE.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Practical

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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UNIT 8.2: Customer Verification Process

Unit Objectives
At the end of this unit, you will be able to: 
Understand the customer verification process

8.2.1 Customer Complaint

Verification of the Customer
To most of us, there may be some instances where we called customer service; It could be just an inquiry or a complaint. 
However, have you observed that in almost all of your calls, the representative asks for your identification? Why is call 
verification so important?

Answer is to keep customers data and service safe for example if CCE does not follow verification process and activates 
some service the customer may come to know when he receives bill in which charges will be there. 

Customer Verification is the process where CCE verifies the customer on behalf of the company before 
being allowed to activate and deactivate services.

Verification Scenarios
Below mentioned are scenarios wherein CCE is supposed to verify

 ● Balance depletion
 ● PUK information
 ● Activation and deactivation requests
 ● Called number information
 ● While raising request/complaints (except DND and network)

Verification Parameters
CCE can ask following questions (only two) to verify the customer before activating and deactivating any service

 ● Name of the customer (As per CRM)
 ● Address of the customer (As per CRM)
 ● Proof submitted by the customer
 ● Frequently dialled numbers
 ● Last 3 calls or SMS numbers
 ● Date of birth of the customer 

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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True or False

1. Verification helps in controlling fraud.

2. Any changes can be made to the customer’s account without verification.

3. Verification is generally not required in a scenario where a customer is asking for a particular department’s 
contact number or operational hours.

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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_______________________________________________________________________________________________
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About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

132

Customer Care Executive (Call Centre)Participant Handbook

UNIT 8.3: Addressing Quick Response Code

Unit Objectives

8.3.1 Addressing Customer QRC
 ● Categorize the customer call into Query/Request/Complaint as per resolution and not as per customer VOC (Voice 

of Customer).
 ● Obtain sufficient information from the customers to login their request or complaint.
 ● Give resolution time to the customer.
 ● Share TAT with customer while raising any request or complaint.
 ● Share request/complaint number with customer while raising any request or complaint. 
 ● Try to resolve the customer complaint at your end through effective probing and system check.
 ● Verify customer details in account related and PUK information calls.

List of Common requests
 ● Request for activation/deactivation of service
 ● Request regarding change of plan
 ● Request for activation/deactivation of promotional pack

Handle Situations

1. A customer yells at you because he is not happy with the services of his mobile network. He has previously also 
requested to look into the matter, but still the problem persists. He is upset and wants an immediate solution.        
________________________________________________________________________________________

2. A customer calls you to request a change in caller id. You are explaining him the process. But he is not able to 
understand it. 

        _______________________________________________________________________________________

Exercise

At the end of this unit, you will be able to: 
1. Understand how to address customer QRC

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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UNIT 8.4: Escalation

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the Escalation Process

8.4.1 Escalation Process
Before escalating call of the customer CCE should make an attempt to identify and resolve QRC in following ways:

 ● Empathize with the customer
 ● Listen attentively to the customer’s QRC and do not interrupt 
 ● Review the account and complaint details
 ● Ask probing questions to ensure understanding of the issue
 ● Take the appropriate steps to correct the issue

If the customer still insists on speaking with a manager,
 ● Escalate the call to the supervisor instead of arguing with customer
 ● Provide the supervisor with information regarding the customer and the issue
 ● If no one is available immediately to handle the customer’s call, offer the customer the option of receiving a call-

back from a member of management within 2 hours
 ● Inform the customer that you are transferring his call to the supervisor

True or False
a) Before making the customer talk to the supervisor we need to provide the supervisor with information 

regarding the customer and the issue.
              ________________________________________________________________________________________ 

b) CCE can ask date of birth of customer before giving PUK number.
              ________________________________________________________________________________________

c) Escalation is required in every complaint call. 
              ________________________________________________________________________________________

d) You may interrupt the customer while he is talking.
              ________________________________________________________________________________________

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1. List down a few scenarios when you may need to escalate the problem to your supervisor.
        _______________________________________________________________________________________

        _______________________________________________________________________________________

       _______________________________________________________________________________________

       _______________________________________________________________________________________

2. Scenarios to check resolving customer query, request and complaint.

a) Customer complains that his number is not working and prompt is PUK.
               _______________________________________________________________________________________

              _______________________________________________________________________________________

              _______________________________________________________________________________________

              _______________________________________________________________________________________

b) Customer has activated DND on his number month ago. However, he is getting calls from insurance companies, 
customer wants to bar these calls.

 _______________________________________________________________________________________

 _______________________________________________________________________________________

              _______________________________________________________________________________________

              _______________________________________________________________________________________

Practical

Notes
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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Key Learning Outcomes
At the end of this module, you will be able to:

1.  Explain the importance of  developing customer relationship
2.  Classify customers into different categories and service them accordingly
3.  Understand the feedback recording process
4.  Provide complete resolution of customer issues in an effective manner
5.  Know how to escalate customer issue to guarantee customer satisfaction
6.  Practice introducing new services to customers

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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UNIT 9.1: Introduction

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of customer relationship

9.1.1 What is Customer Relationship?
What do you understand by the term customer relationship?

It is an association that exists or existed between an organisation and its customers. Customer relationship can be built 
based on products or services.

Customer Relationship is important for industry. Maintaining customer relationship in a telecom industry is a key factor 
as organisations in this industry generally have long term association with their customers. The process of maintaining 
a good relationship with customer is called CRM (Customer Relationship Management).

CRM helps the organisation to understand what their customers need. It also helps the organisation to cater to those 
needs efficiently, effectively and accurately.

Customer Relationship Management process also requires maintaining information more than a human brain can 
retain, hence companies use CRM tools and applications. Here are some advantages of CRM.

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

138

Customer Care Executive (Call Centre)Participant Handbook

1. Complete the sentences:

a) Customer relationship is important because ___________________________________________________

b) Maintaining a good Customer Relationship will make the customer feel _____________________________

2. List down 5 things that you will do to ensure a good Customer Relationship

i. ______________________________

ii. ______________________________

iii. ______________________________

iv. ______________________________

v. ______________________________

Exercise

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Maintain a History

CRM will help you maintain records of historic purchases and requests. This information will allow you to assess 
customer needs effectively in time, which in turn improves customer satisfaction and increase profitability.

Customer Categorisation
CRM will allow you to categorise your customers according to the value of business they bring and give the organisation 
insight about the kind of service and benefits the customer can expect.

Improves Customer Loyalty
Maintaining a good working relation with your customer will ensure customer loyalty, thus improving customer 
satisfaction and directly impact profitability of the organisation.

Promote Word of Mouth Advertising & Improve Company Reputation.
Maintaining a good and a positive relationship with the customer will lead to a satisfied customer and in turn your 
customers will talk to other people and give a positive opinion, and more the customers you have talking good about 
your company the better your company’s reputation gets.

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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9.2.1 What is Customer Categorization?

9.2.2 Why is it Important to Categorize Customers?

9.2.3 Types of Categorization

In today’s world telecom companies have millions of customers. It becomes difficult to offer each customer products 
and services that are most suitable to their requirements. To overcome this problem and to offer customised products 
and services companies have adopted customer categorization based on a lot of criterias broadly categorised as Land 
Line and Cell phone.

With the large range of products and services offered by telecom companies today, it becomes impossible to offer 
customised services unless you categorise customers to understand their needs. This will in turn help the company 
improve customer satisfaction which would have a direct impact to increase profits.

Now let’s look at the customer categories in a little more detail:

Customers can be categorised as per their geographical location, spending pattern, usage, services used, type of 
service, value added services etc.

UNIT 9.2: Customer Categorization

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of customer categorization
2. Understand the importance and types of customers

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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We will learn about what is relevant to our job function. So let’s look at type of service and usage.

Types of Services

 ● Landline

 ● Mobile

Landline
Landline refers to telephones that are based in a specific house/building

 ● Home

 ● Office

 ● Hotline

Home - A home landline is your regular telephone at home which is either a wired or a wireless. Companies that 
provide wired services are very few like BSNL & MTNL. Wireless landline phones are provided by most leading telecom 
companies like TATA, Reliance, Airtel, Vodafone & Idea to name a few.

Office - Office customers are also called corporate customers. These customers have a specific requirement like having 
1 phone number which can either be a 10 digit cell phone or an 8 digit landline number connected to 1 or more 
instruments termed as extensions and can vary from a 4 digit number to a 7 digit number. Look at the image below for 
better understanding.

Hotline - Hotline is a further complex model to the office connection. This service is largely used by the Customer 
Service industry, followed by Sales. A hotline number has a more complex structure than a office number. A hotline 
number can either be a regular 8 digit number or a 10 digit number like the 1800 series number. This main number is 
connected to an automated system also known as a VRU (Voice Response Unit) that has a recorded voice providing 
customer options. Based on the customer's selection, the system then transfers the call to a sub-prime number which 
then automatically transfers the call to the extension that has been free for the longest time.

Here is an example: you call ABC Telecom at 1800 123 456 and the call is answered by the VRU system and you are 
given 3 options

1. Dial 1 for Service

2. Dial 2 for Sales

3. Dial 3 for Complaints

Now, we have 3 departments and each department has a number which is a sub-prime number under the prime 
number which is 1800 123 456. Based on you selection you will be transferred to that department and within a click 
your call is transferred to the extension of the person who has been available for the longest time.

Fig. 9.2.1 Extension wise call transfer

Extension 1

Central Auto-

mated System or 

a receiver

Main phone 

number

Extension 2 Extension 3
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Mobile 

Mobile is a service which can be used across the globe. Mobile services are categorised as

 ● Pre-Paid

 ● Post-Paid/Billing

 ● Private Numbers

Pre-Paid

Pre-paid is a very simple service type. Pay first and use later. Pre-paid service is where the customer pays the company 
some amount and then makes calls for the amount that has been made available by the telecom company. Once the 
customer has completed using the service for what they have paid, all services are barred except incoming SMS and 
Calls. Pre-paid offers customer to be in complete control of his expenses.

Post-Paid

Post-paid follows the fundamental of use first and pay for what you have used. In this service the customer uses the 
service first and then pays at the end of each month based on what they have used. This kind of service allows less 
control on expenses as compared to pre-paid. Here the customers are provided a grace period to pay their bills and 
only post that will the services be barred.

Private Number

Private numbers are generally provided to elite / VIP customers who are mainly public icons or popular personalities. 
In this type of service you can choose to customise your service as you wish to, for e.g only receive incoming calls from 
selected numbers. The number is not published to public and is available only to selected staff under information 
security policy, it does not display number to the receiver when a call received from a private number and no restrictions 
of using the service across the globe are a few benefits. This service is not available to all as you require government 
permission and police permission, secondly this is a premium service and so the charges are also on a higher side.

Fig. 9.2.2 Extension wise call transfer - Prime number
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 True or False

1. Use first and pay later is a principle followed in a prepaid mobile service.

2. A Hotline number can either be a regular 8 digit or a 10 digit number. 

3. Office line customers can't be called corporate customers.

4. A home landline has to be a wired connection.

1. A customer calls you up and he wants a new private number which he wants to keep confidential. What will you 
do?

       ___________________________________________________________________________________________

       ___________________________________________________________________________________________

Exercise

Practical

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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9.3.1 What is Customer Feedback?

9.3.2 Importance of Customer Feedback

9.3.3 Advantages of Customer Feedback

Organised information collected from your customer about their opinion, suggestions and experience about the 
product or service is called feedback.

Customer feedback allows telecom companies to better understand how customers rate and use their products or 
service as against competitive products. It is of high importance for determining where a company’s products and 
services excel or fall short against customer’s expectation and against alternate service providers in the market. For 
example, customers may like the network coverage of ABC Telecom as against XYZ Telecom, which means that XYZ 
Telecom would need to improve on their network coverage.

Customer feedback can help telecom companies in evaluating how employees treat customers. Customer Service 
Satisfaction surveys are a common type of marketing research. Companies can determine through surveys whether 
customers are getting their questions answered and problems resolved. Additionally, a company can determine if some 
customer service representatives are being rude to customers, especially if the topic of rudeness comes up frequently 
during the surveys.

Get Honest Opinions
Customer feedback is vital to telecom industry to get honest opinions on services or products from customers. These 
opinions can make it easier to get into the minds of the most important critics.

Improve Relations
To ensure that customers remain loyal to your company, make your customers feel that your company truly cares about 
them and what they think. obtaining feedback from the  customers is indicative of the fact that the compoany truly 
listens and respects their opinions.

Inexpensive Business Advice

Customer feedback is essentially inexpensive business advice directly from the source. Some companies pay a huge 
amount for someone to come in and tell them what improvements need to be made to products and services to win 
over new customers.

UNIT 9.3: Customer Feedback

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of customer feedback
2. Understand the importance and advantages of customer feedback

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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More Customers

When a business is willing to receive feedback and listen to it, word spreads and the customer base increases.

Positive Changes
No company likes to talk about the negative aspects of their operation. They want to have mostly positive feedback 
from customers. Therefore customer feedback can mean positive changes according to their comments, which could 
mean a better reputation and more money for the business.

Capturing in Timely Manner
In today’s competitive Indian telecom market, it is very important to capture customer feedback in a timely manner. 
This will allow your company to improve their product or service and also enhance customer satisfaction.

9.3.4 Feedback Recording Process
Here is the way telecom companies capture customer feedback.

For a telecom company, it is the frontline staff that speak to customer’s day 
in and day out, Hence it makes it really important that companies put a 
feedback recording process and train its frontline staff on how to deal with 
angry customers and record feedback.

Let us look at the feedback recording process first.

Take Customer Details
The first thing you do before you proceed in logging customer feedback 
is to ensure that you have all the required customer information like the 
customer’s telephone number, mailing address & name. This is required 
to ensure that you access and record the feedback for the right customer.

Check for similar feedback in history
Check if the customer has complained or provided feedback for the same 
situation, because sometimes it could be that the instrument that the 
customer is using is faulty and there is no problem in the service provided. 
This procedure can also result in immediate resolution and improving 
customer satisfaction.

Create a feedback / Complaint Reference Number
Every time you log a feedback or a complaint on the customer’s account, 
the system generates a reference number which the customer can use 
to follow up and check for resolution status. This also helps telecom 
companies to categorise complaints and ensure that based on the nature 
of complaint a specialist can speed up the resolution process.

Type the feedback in customer words
Type the feedback in customer words as much as possible. It is human 
nature that a person can best explain a problem when he has been facing 
the problem. When your customer faces a problem and is giving feedback 
about the same they are able to emphasize on it with specific words Fig. 9.3.1 Process of Recording Feedback

Ensure to submit/save

Provide customer with 

reference number

Create a feedback 

reference number

Check for similar 

feedback in history

Take customer details

Type the feedback in 

customer words
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Provide customer with 

reference number

Create a feedback 

reference number

Type the feedback in 

which help the resolution team to understand customer’s dis-satisfaction level. This will also allow the specialist to 
understand the exact problem.

Provide customer with reference number
Provide your customer with the feedback / complaint reference number as they will call back if the problem is not 
resolved within their expected time. Providing customer with the reference number will allow the other customer care 
executive to locate the feedback form and provide customer with an update without wasting time.

Ensure to submit/save
This is a very small action in the process but can become the biggest problem when not done. Submit/save the 
feedback/complaint immediately after you are done talking with the customer. Not following this step or human error 
can result in either no resolution or a call back to the customer thus wasting time.

Let’s look at a simple process in dealing with customers who have a feedback or complaint.

 ● Greet

 ● Listen

 ● Acknowledge

 ● Apologise or Thank

 ● Reconfirm

 ● Reassure

Greet: It is important to greet the customer as this will act as a conversation starter and make the customer feel 
welcome and that he has a real person on the other side of the call.

Listen: When your customer is giving feedback they want to be heard and would not want you to be interrupting them.

Acknowledge: When your customer is talking they also need to know that they are being heard and are talking to a 
person. Use verbal nods like “Ah-ha” “ok” “alright” etc. This will let the customer know that you are interested in what 
they have to say and also understand what they are talking about.

Apologise or Thank: Say that you are sorry for what has happened and that you will ensure that the issue is resolved 
as soon as possible if the customer is calling for a negative feedback or a complaint. Say Thank You when the customer 
is calling you for a positive feedback or giving a compliment.

Reconfirm: Customers would like to know if you have really understood what their issue is and this can be done by 
telling the customer what you have understood. This is called reconfirming as this will allow you to clear any doubts or 
seek information you need to ensure that the issue has been resolved.

Reassure: Always use statements like “Don’t Worry” “Be rest assured” “I will help you” as this will make the customer 
feel that you have understood their problem and know how to resolve it.
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1. Identify from the following the feedback parameters for the company and the customer care executive.

Soft Skills/Voice Quality/Wait Time in getting through the executive/Product Knowledge/Timely Resolution of the 
Problems/Brand Rating

Customer Care Executive Company

 

2. State True / False

a) Customers are the most important critics.

b) Customer feedback does not make a lot of difference to the work I do as a Customer care executive.

c) Capturing feedback in a timely manner is very important to enhance customer satisfaction.

3. Fill in the blank

The first step in recording a feedback is ____________________________________ (documenting/listening)

1. A customer had requested your organization to change his 3G plan and convert it to a 2G plan some 3 days back. 
You have to take his feedback, document it and process it for rectification. (The customer’s request was not met 
and he is not happy with the service.)

       ________________________________________________________________________________________

       ________________________________________________________________________________________

       ________________________________________________________________________________________

      ________________________________________________________________________________________

Exercise

Practical

Notes
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize
About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
…..
…..

Participant Handbook

vi

Symbols Used

Steps Unit
Objectives

Key Learning
Outcomes

Notes

Practical Exercise Summarize



Participant Handbook

147

Customer Care Executive (Call Centre)Customer Care Executive (Call Centre)

147

9.4.1 What is Customer Satisfaction?

9.4.2 Ensuring Customer Satisfaction

Customer satisfaction is a term used to define how satisfied is the customer with the product or service you provided. 
Customer satisfaction is very important for the telecom industry as relationship with customers are always long term. 
And to retain loyalty you need to ensure that your customers are satisfied.

What do customers expect from us?

Knowledgeable and available

In the telecom industry, when customers call the customer service centre they expect to obtain accurate information 
when they want it. You need to ensure that you know about all new updates to the range of products and services the 
company has to offer, you also need to know how to navigate to customer's account information as customer may ask 
for his current plan details.

Friendly People
Everybody wants to be treated in a very friendly and a welcoming manner, and so does your customers. You need to 
ensure that you sound and speak in a friendly and welcoming tone but also maintain professionalism. This means that 
you need to make the customer feel comfortable and always offer assistance.

Good Value

This is where most of us make a mistake. When we talk about good value we always think about the pricing factor, 
but that’s just a part of it. There are other aspects that add to good value like how well is your product suitable to 
customer's need, what are the advantages and how will it add value to his needs against their current product or 
service.

Convenience

The rule here is simple- “Make it easy”. Telecom customers today want things to be attractive, easy to understand and 
simple to use. The simpler your explanation the better the understanding. Remember you are trained to know all the 
abbreviations not the customers so ensure you speak in a simple language that your customers can understand.

UNIT 9.4: Customer Satisfaction

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of Customer Satisfaction
2. Understand the escalation process
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National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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A Fast Finish
This is where we tend to make the biggest mistake- “The Finish”. The moment the customers have their required 
information they don’t wish to waste time and finish with the call. Don’t try and push to waste their time. If you need 
to up-sell or cross-sell make it a part of your conversation and not keep it for the last for it to sound like a complete 
sales conversation. 

There are a lot of things in today’s world that make life difficult for all of us. Remember that your customers also face 
the same in their life, overall they expect to be treated in a professional way, they want to be heard and valued for the 
business they provide. If you provide easy and convenient service you will exceed customer expectations.

Giving Additional Information
With the range of products and services telecom industry has to provide today it is critical to give additional information 
to the customers. This will make the customer feel valued and that you really care about them getting the best. Let’s 
look at some advantages of giving additional information:

Improves Customer Satisfaction
By giving additional information that is relevant to customer's request / query makes your customer feel that you 
are listening truly and care about their question or issue and genuinely want to help. Thus improving customer’s 
satisfaction.

Improves Profits
When you provide service that exceeds your customer’s expectation then the customers are happy and will always 
return to you for the next requirement that they have which will increase company's profits.

Builds Customer's Confidence
When you provide additional information that customers need to know from the service provider the customer will 
always trust on what the company has to say and offer.

Creates a good company image

In today’s competitive telecom industry, company image can be the deciding factor for potential customers. In simple 
words if your friend tells you that he has trouble with his/her service provider very often, even you might reconsider 
your decision if you want to buy services from the same company.

Feel Good Factor
When you provide additional information to customers some of them will appreciate the efforts that you have made 
and will provide a positive feedback which will make you feel good about what you are doing and also help improve 
your performance.

Open Opportunities
Giving additional information will make your customers talk more about their service using pattern and needs, this will 
give you opportunities to offer new services to your customers which will better cater to their needs.
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9.4.3 Complete Resolution
Telecom industry today strives to provide complete resolution to issues faced by customers as moving service provider 
by keeping the same telephone number has become easy and is a hassle-free process. 

First Call Resolution
In telecom customer care FCR (First Call Resolution) holds a lot of value.

What is FCR?
The process of resolving and providing a solution to customer concerns and issues at the time they first speak about 
it is called First Call Resolution. For example, customer calls and informs you that they are unable to connect to the 
internet, and you ask the customer to check on the settings and resolve the issue by asking customer to make minor 
changes to the settings. In this example you are able to help the customer connect to the internet and resolve the 
problem at the first call the customer has made about the issue.

Let’s look at 3 advantages of providing FCR:
Improves Customer Satisfaction
First call resolution has a direct impact on your customer satisfaction scores. The more FCR you provide, the more your 
customers are happy. Thus you get a better customer satisfaction level. 

Less Call Handling Time
Providing FCR means that customers would not need to call back. Having your customer call back with the same issue 
means that the customer will be irritated about the ongoing issue and an irritated customer means that they would 
want to vent it out which will increase your call handling time.

Increase the opportunity to sell

Providing FCR means that your customers will have more faith and trust in you and clubbed in less call handling time 
gives you more opportunity to sell and with customers faith the acceptance level is high which will result in successful 
sales conversions.

Reduce loss of customers
As discussed earlier that the competition in the telecom market is significantly high providing customers with lots of 
options. Providing FCR will ensure that your customers stay with you. Research shows that companies that believe 
in FCR loose about 2% of customers who have issues and complaints, and companies that do not focus on FCR loose 
about 19% of customers who have issues and complaints.

9.4.4 Escalation
What do you understand by the term Escalation?
Escalation in the telecom customer care means taking ownership and passing on the customer’s problem for resolution 
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to someone else in situations where you are unable to resolve the problem. Let’s look at an example, You have a 
customer who is calling and asking for a refund of charges deducted from their balance, a customer care executive 
does not have the authority to agree to refunds, in this situation you will need to refer to your team leader for 
authorization or transfer the call to a team leader for the resolution.
In situations where you have to escalate the problem to a senior person, the customers are most often angry. We have 
already looked at handling angry customers earlier, but let’s look at it again

Steps involved in handling angry customers

Greet

It is important to greet the customer as this will act as a conversation starter and make the customer feel welcome and 
that he/she has a real person on the other side of the call.

Listen
When your customer is giving feedback they want to be heard and would not want you to be interrupting them.

Acknowledge

When your customer is talking they also need to know that they are being heard and are talking to a person. Use 
verbal nods like “Ah-ha” “ok” “alright” etc. This will let the customer know that you are interested in what they have 
to say and also understand what they are talking about.

Apologise or Thank
Say that you are sorry for what has happened and that you will ensure that the issue is resolved as soon as possible if 
the customer is calling for a negative feedback or a complaint. Say Thank You when the customer is calling you for a 
positive feedback or giving a compliment.

Reconfirm
Customers would like to know if you have really understood what their issue is and this can be done by telling the 
customer what you have understood. This is called reconfirming as this will allow you to clear any doubts or information 
you need to ensure that the issue has been resolved.

Reassure

Always use statements like “Don’t Worry” “Be rest assured” “I will help you” as this will make the customer feel that 
you have understood their problem and know how to resolve it.
The most important thing to remember is, never say “I cannot help you” or “I need to take authorisation”, this will 
only depict that you are incapable of handling the situation. Instead say “Give me a moment while I check for some 
information” or “Can I get a minute or two to check some information”.
Now let us look at the escalation process:
Take permission for hold
Always take permission from customer before you place them on hold and let them know how long you will put them 
on hold and, make sure you get back to your customer within the time given.
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Acknowledge

When your customer is talking they also need to 
know that they are being heard and are talking 
to a person. Use verbal nods like “Ah-ha” “ok” 
“alright” etc. This will let the customer know that 
you are interested in what they have to say and also 
understand what they are talking about.

Apologise or Thank
Say that you are sorry for what has happened and 
that you will ensure that the issue is resolved as 

Place on hold

Ensure that you mute your call and place check if the call has been put on hold, you don’t want the customer to be 
listening to you speaking to your senior, this will again make the customer lose confidence in you.

Inform before you transfer
Always make sure you get back to your customer and inform them that you are going to transfer the call to your senior 
who will help resolve the issue.
Introduce before you disconnect
Always introduce your customer to your senior and explain the situation in brief on the call before you disconnect 
yourself from the conversation. You also need to acknowledge to the customer by saying “Mr. Kumar my colleague will 
now help you further”.

soon as possible if the customer is calling for a negative feedback or a complaint. Say Thank You when the customer is 
calling you for a positive feedback or giving a compliment.

Reconfirm
Customers would like to know if you have really understood what their issue is and this can be done by telling the 
customer what you have understood. This is called reconfirming as this will allow you to clear any doubts or information 
you need to ensure that the issue has been resolved.

Reassure

Always use statements like “Don’t Worry” “Be rest assured” “I will help you” as this will make the customer feel that 
you have understood their problem and know how to resolve it.
The most important thing to remember is, never say “I cannot help you” or “I need to take authorisation”, this will 
only depict that you are incapable of handling the situation. Instead say “Give me a moment while I check for some 
information” or “Can I get a minute or two to check some information?”
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1) State True / False

a) Customers expect you to provide them a delightful service by giving them at an instant what they want.

b) If you want to up sell or cross sell a product or a service you should do it just before ending the call.

c) When the customer talks of value of the product or a service he/she is just talking about its price.

d) It is ok to make the customer wait for a query related to a new service plan. 

2. Fill in the blanks

a) What is the full form of FCR? _________________________________

b) FCR has ________________________________ impact on customer satisfaction. (a direct/ an indirect)

c) To make the customers happy his/her expectations should ______________________________ the service 
levels of the CCE.

3. A customer calls and informs you that he/she is unable to connect to the internet. What will you do? (Give clear 
instructions to the customer and try to solve the issue at that time only.)

4. The customer after putting in wrong password many number of times have now lost access to his account. How 
can he recover his password?

1. The customer calls you and asks you to find out a reasonable plan for him. He states that he travels a lot and is most 
often on roaming. You have to suggest him some two to three plans that would be cost effective for him, giving him 
the additional information like SMS packs, 2G services that he can club with the plan to make it more cost effective.

      ___________________________________________________________________________________________

      ___________________________________________________________________________________________

      ___________________________________________________________________________________________

      ___________________________________________________________________________________________

Exercise

Practical

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________ 

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes
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UNIT 9.5: Introducing Customers to New Services

Unit Objectives
At the end of this unit, you will be able to: 
1. Learn the importance of introducing new products and services.

9.5.1 Introducing new Products and Services

Why is it important to introduce new products and services?

Sales in the telecom industry is a part of service. Your customers today have varied needs as time passes by. For e.g. 
Internet based chat applications have taken over the market and SMS is barely used, this has shifted customer needs 
from having SMS packs to having internet packs. Now keeping in mind the above example it is your responsibility 
to ensure you inform your customers about new plans available that will benefit them. This will improve customer 
satisfaction and profitability.

Introducing a Product

Customers calling the call centre are aware that they will be asked to buy something and become defensive the 
moment their query is resolved. This does not give an opportunity to the CCE to introduce a service that will benefit 
them.
It is a very simple technique of being natural and being human. Let’s look at the process of introducing a product or 
service. 

1. Build Relationship
You are not an automated machine or a computer, so be yourself and talk to the customer in a tone you speak to 
another person. This will give you the space to build a relation with the customer.

2. Check Customer's Information
While you assist the customer with their query, check and make notes of their usage trend and what are the active 
services. This will allow you to offer the most appropriate product or service.

3. Position Yourself
Positioning your offer is the critical part. You will always face denial if you offer after saying the closing statement “Is 
there anything else I can help you with today”. This is where your customers get defensive and deny offer. Make sure 
you link it once you are done with customer’s query, use statements that the customers can relate to for e.g. “I noticed 
that you have been paying huge roaming charges, do you know we have a roaming plan that can help you cut down 
your costs”.

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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4. Close the Deal

Your customers will rarely say “I want it”, so ensure that you 
facilitate customer's decision making. Do not decide on their 
behalf but just facilitate by showing them the benefits by linking 
the benefits to their current usage.

5. Reconfirm Purchase
Make sure you reconfirm the purchase, as sometimes your 
customer's will still be unsure when they say yes over the 

1. What is right/What is wrong?

ii. Categorizing customers 

iii. Waiting for the customer to ask a query instead of asking him ‘How can I help you?’

iv. Interrupting a customer while he is talking about the features he is looking for in the service.

v. Politely asking a customer the reason for his decision of not continuing the service.

vi. Telling the customer about the other products or services he can avail just before ending the call.

2. What are the few factors to be considered while upgrading the customers to a new product or a service?

       __________________________________________________________________________________________

__________________________________________________________________________________________

      __________________________________________________________________________________________

      __________________________________________________________________________________________

1. Deal with the situations given below:

a) Your customer shouts at you because he has been suffering from a bad network connection from a past few 
days.

        _______________________________________________________________________________________

        _______________________________________________________________________________________

               _______________________________________________________________________________________

               _______________________________________________________________________________________

telephone, after all you do not want a dissatisfied customer.

6. Thank
Do not forget to thank your customer while ending the conversation. Closing the conversation is as important as 
opening. At the end of the conversation your customers may not remember how you opened the call but they sure 
will remember how you closed it, so ensure you thank with a smile.

Exercise

Practical
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b) Your customer wants to speak to your supervisor and tell him the problem he has been facing in the account.
        _______________________________________________________________________________________

               _______________________________________________________________________________________

               _______________________________________________________________________________________

        _______________________________________________________________________________________

c) The customer is not very clear with the problem he has been facing with his data card. But he is not very happy 
with the speed.

        _______________________________________________________________________________________

        _______________________________________________________________________________________

        _______________________________________________________________________________________

        _______________________________________________________________________________________

d) The customer wants a customized private number which is not available right now.
        _______________________________________________________________________________________

        _______________________________________________________________________________________

        _______________________________________________________________________________________

        _______________________________________________________________________________________

Notes

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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Unit 10.1 – Self Reports

Unit 10.2 – Review with Supervisors

10. Report and Review

TEL/N0103
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Key Learning Outcomes
At the end of this module, you will be able to:

1.  Monitor and manage self-performance through reports and review process
2.  Understand the performance parameters to make self-reports
3.  Practice self-review with superiors
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UNIT 10.1: Self-Reports

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of reports and review
2. Understand the concept of self-reports
3. Understand the performance parameters to make reports

10.1.2 Performance Parameters
Let’s look at some common performance parameters in the telecom industry:

Time-Based

 ● Login Time
The number of hours that you have logged in against the time you were supposed to login. This is usually calculated in 
percentage. Let us look at a simple calculation to understand it.

Example:

In a 9 hour shift you have 1 hour of break which means that you are expected to login for 8 hours every day. Your total 
working days in a month is 25 days. You have logged in for 190 hours in the month.

 » Shift Hours minus Break Time = Expected Login time

9 hours – 1 hour = 8 hours

 » Expected Login Time multiplied by 25 days = Expected monthly login time

8 hours x 25 days – 200 Hours

 » Expected Monthly Login Time divided by Actual Login Time = Login Percentage

190 Hours / 200 hours = 95%

 ● Customer Contact

Customer contact is the number of customer that you have spoken to in the review period. Generally telecom 
companies don’t set targets on the number of calls you need to answer as AHT takes care of that. However, it is always 
good to keep a track of this.

10.1.1 Overview of the Module
Everyone expects to become the best at what they do. So how do you really know who is the best? It is through 
performance reviews against peers and targets set by the company.

There are multiple review periods in a telecom contact centre, we will look at different review stages and why they are 
done.

About this book
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National Occupational (NOS) is covered across Unit/s.
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 ● Avg. Call Holding Time (ACHT)
There is a difference between Avg. Call Holding Time (ACHT) and AHT. AHT includes the time you have spent on 
Average Call Waiting (ACW) as well, this is done because ACW is a process of the call but the customer is not online. 
ACHT is the actual time spent on the call i.e. AHT minus ACW time is called ACHT. All of these measurements are 
usually calculated in seconds.

Example:
Let’s say that your AHT for the month is 450 seconds, ACW time is 15 seconds. The target for AHT is 380 seconds, ACW 
is 20 Seconds and ACHT is 360 seconds. Some telecom companies also calculate these in percentage.

AHT - ACW = ACHT

450 seconds – 15 seconds = 435 seconds

Actual AHT divided by Target AHT = AHT Percentage

450 seconds / 380 Seconds = 118% (This means that you have not met the target and are over it by 18%)

Actual ACW divided by Target ACW = ACW Percentage

15 Seconds / 20 Seconds = 75% (This means that you have met your ACW target)

Actual ACHT divided by Target ACHT = ACHT Percentage

435 Seconds / 360 Seconds = 121% (This means that you have not met the target and are over it by 21%)

The above example shows that having a low ACW will not ensure that you meet the ACHT target, you also need to 
reduce your actual time you spend on the call with the customer to meet ACHT.

Soft Skills
Apart from the above time based performance criteria, your performance will also be judged based on soft skills i.e. 
the way you take call or in other words the quality of the calls.

Soft skill parameters are simple to understand. Let’s look at general telecom quality parameters

 ● Greeting – Have you used the appropriate greeting?

 ● Listen – Have you listened to the customer carefully or made them repeat?

 ● Solution – Have you offered relevant and accurate information and solution?

 ● Offered new services – Have you offered new services to customer based on needs?

 ● Offer Assistance – Have you checked if customer required further assistance?

 ● Close – Have you closed the call on a positive note?

 ● System Update – Have you updated customer information appropriately?

1. What Parameters are used to evaluate Performance in Telecom Industry?

a) Time-Based

b) Soft Skills

c) Both

Exercise
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Make a call from your mobile and follow the transfer the hold and transfer procedure.

1. Make a simple calculation and provide the following information:

a) ACHT

b) AHT

c) Hold Time

___________________________________________________________________________________________

___________________________________________________________________________________________

____________________________________________________________________________________________

Practical

2. Name three Time-Based Performance Parameters

a) __________________________________________________________________

b) __________________________________________________________________

c) __________________________________________________________________

3. Give the Full forms of following:

a) AHT

b) ACHT

c) ACW

4. Name three Soft Skills Performance Parameters

a) __________________________________________________________________

b) __________________________________________________________________

c) __________________________________________________________________

5. What is Hold time?

___________________________________________________________________________________________

___________________________________________________________________________________________

6. Calculate Call Login Time

In a 9 hour shift you have 1 hour of break. Your total working days in a month is 22 days. You have logged in for 185 
hours in the month. Calculate Login Time & Percentage.

Calculate following percentages:

Let’s say that your AHT for the month is 400 seconds, ACW time is 12 seconds. The target for AHT is 350 seconds, 
ACW is 15 Seconds and ACHT is 320 seconds. Calculate AHT, ACW and ACHT percentage.

ACHT =

AHT Percentage =

ACW Percentage =

ACHT Percentage =
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UNIT 10.2: Review with Superiors

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand and practice how to review self-reports with superiors

10.2.1 Review with Superiors
Performance parameters provide an indication of your performance by measuring key processes. By monitoring the 
right parameters, you can gain valuable insight into your performance and make the adjustments needed to optimize 
your performance. Following points will help you in review with your superior.

 ● Know which parameters are most important to monitor to get the results you want. 

 ● Know definition, calculation, and example of each parameter.

 ● Prepare for the discussion with the superior.

 ● Solicit feedback from superior.

10.2.2 Review Period
Now let’s look at review periods in a telecom contact centre.

Monthly

Monthly reviews are done to ensure that every one is aware how they are performing and know who really is doing 
good and who needs guidance and help with regards to their performance.

Quarterly

This is done every three months to know a cumulative performance and to know how your performance will look like 
at the half yearly review.

Half Yearly
Done every 6 months to judge agents for reward & recognition and also to let you know how your annual performance 
will look like if you continue the same performance trend.

Annual

This is the review that will be considered for salary raise if performance is good or for corrective measures if you are 
below the company standards.

Always ensure that you look at your performance report on a daily basis, if daily reports are unavailable then look at 
weekly measures.
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1. What are the review periods?

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

2. Why are reviews done?

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

1. Give solution to following scenarios:
a) Customer complains that he is not getting any signals on his number while he is at his home and due to which 

most of time he is not able to receive or make any call/SMS.

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

b) Customer want only few marketing calls on his number as he has already activated DND on his number.

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

Exercise

Practical

Notes
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Key Learning Outcomes
At the end of this module, you will be able to:

1.  Identify opportunities for pro-active selling at the call centres
2.  Practice up-selling and cross-selling

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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UNIT 11.1: Proactive Selling

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the concept of proactive selling

11.1.1 Proactive Selling
Selling a product or service to a customer is challenging. It is even more challenging when you have to do selling over 
the phone. Let us learn how a product is sold over the phone. As a BPO employee, you may have to sell products over 
the phone.

A customer calls a telecom company and gets connected to Sumit, a telesales representative. After talking to Sumit 
he calls a competing company and gets connected to Apoorva. Let’s observe how the conversation flowed in both the 
cases:

 ● Sumit: Good morning, this is Sumit from Axis telecommunication, how can I help you?

 ● Customer: I want to buy a post paid plan for myself that suits my needs.

 ● Sumit:The basic plan that we offer is only Rs. 350 per month and you get 25 SMSes free. Can I sign you up for this 
plan Sir?

Now let’s observe the conversation with Apoorva:

 ● Apoorva: Good morning, this is Apoorva from Dot telecom, how can I help you?

 ● Customer: I want to buy a post-paid plan for myself that suits my needs.

 ● Apoorva: Sure, Sir may I know how much of talk time you require in a month? Do you call on a specific number 
often?

 ● Customer: Not much, I don’t talk much and yes, I do call one number very often. 

 ● Apoorva: I understand. Sir, you may want to try our 121 package that enables you free talk time of 3 hours monthly 
on a single number and the monthly plan would be Rs. 300 only. Would you like to buy this plan Sir, if you think it 
can meet your needs? 

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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Phase 2  ● Clarify (ask questions)
 ● Ask questions to identify the need. This will help you in pitching, up selling and cross selling.

Phase 3  ● Summarize (what the customer needs) to check that there is no misunderstanding.
 ● This is a critical conversation and you might not get a second chance to do this. So keep 

confirming and checking.
Phases 4 to 7: 

The seller leads the action
Phase 4  ● Propose (a solution that matches the detected needs)

 ● This is where you pitch the product, after assessing the need of the customer.
Phase 5  ● Demonstrate (the advantages of the solution)

 ● Map the benefits of the customer with the advantages and the features of the product. 
Phase 6  ● Welcome the objections (declare we understand them). Be prepared beforehand to answer 

them.
Phase 7  ● Help the customer to decide (bring a sense of urgency)

 ● Closing the sale is the most important aspect. All the steps above are of no use if the sale is 
not closed.

Example:
We will now see how to sell products by applying the above mentioned skills. The first stage is to gather information. 
Let us see in this example how Rita gathers information:

Rita works for a telecom BPO. Her job is to sell various mobile phone plans and other value added services like internet 
on the phone, caller tunes etc. 

Rita: Before I offer you a plan Sir, I would like to know how much do you think you would use the internet on your 
phone? Do you just want to browse the net or would you be downloading from the net? If you could share with 
me what you are really looking for I could give you a few options.

Customer: Oh yes, actually, I just want to see emails, I don’t think I would need to download anything from the 
net on the phone.

Rita: In that case Sir, you need to go for a basic plan as you would be using the internet service on your phone for 
limited period only.

Asking questions and listening will allow you to gather information that will increase your chances of success with 
the sale. In this case, we have seen how asking questions and listening to the customer actually clarifies what the 
customer is looking for. It helps you to offer what the customer wants. 

Now let us see how the next stage of summarizing and building trust helps in the selling process:

Rita: As you mentioned you would not be downloading anything from the internet and that your requirement is 
only to access your emails, I suggest you take our basic plan that allows you to configure three different email ids.

11.1.2 Steps in Selling
Sellling over the phone require some skills. You have to be a great listener and an effective communicator.

Good sales people have a certain understanding of closing a sale. Follow the phases given here:

Phases 1 to 3: 
The seller tries to understand and is mostly silent

Phase 1  ● Listen (to the customer / prospect situation and needs)
 ● When you introduce yourself to the customer, listen to the customer needs. 
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11.1.3 Up-selling and Cross-Selling

A CCE doing proactive selling will be required to also up-sell and cross-sell. In order to do so he must understand not 
only his own offerings but the competitive offerings as well.

A customer calls a CCE to complain of his bill being very high each month. After acknowledging the customers complaint 
the CCE has a look at the customer’s usage pattern from the CRM and realises his bill value is high because of roaming. 
The CCE sees this as an opportunity to create value for the client and cross sell to him another plan which will be more 
useful to the client. He begins the conversation with the customer:

CCE: Sir what is your monthly usage? 

Customer: I make lots of calls from my phone, about 40-50 calls in a day.

CCE: Sir, Do you make STD and ISD calls from your phone?

Customer: Yes I travel a lot and most of the times my phone is on roaming.

CCE: Then your monthly bills must be quite high, isn’t it Sir?

Customer: Yes, It is always more than Rs. 2500 in a month?

CCE: It’s quite high sir, why don’t you take a travel plan?

Customer: What is a travel plan?

CCE: Sir your monthly fix charges for travel plan will be Rs. 299 plus service tax. Your call rates from xyz to xyz will be 
50 paise per minute, xyz to other operator will be 50 paise per minute and xyz to landline will be 50 paise per minute. 
For video calls you will be charged Rs. 3 per minute. Flat 50 paise per minute will be the charges for all STD calls.

Customer: This sounds good, but I was getting the same deal with India Phones. Why should I go with you?

CCE: May I bring to your attention a few details Sir, India Phones is offering the same plan as us, however they charge 
a processing fee for video calls.

Customer: Oh! I didn’t know that. 

CCE: Sir, Do you use internet on your phone?

Customer: Yes for checking emails and getting updates on social sites only.

CCE: Then, I will suggest you to take Rs. 199 monthly rental plan. In this plan you will get 2 GB of monthly data usage 

Customer: Oh! That’s great. That is my actual requirement (frankly speaking), thank you very much!

Knowing how to effectively ask questions and listening helped Rita to build trust. The customer now trusts what 
Rita says.

The last stage is to finally offer the product and close the sale. Let us see how this can be done. 

Rita: Sir, I think you should buy our internet package - super business. The monthly rental for this package would 
be only Rs. 150. Your services will be activated within 24 hours. Should I activate this plan for you Sir?

Customer: Oh! Sure.

Rita: I hope you like our services. Thank you Sir.

Customer: Thank you.

Did you observe how Rita closed the call? Remember, closing the call is as important as the beginning. If you close the 
call properly the customer feels happy! 
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which is sufficient to meet your requirements. 

CSR: Can I sign you up for this plan Sir?

Customer: Yes sure.

CCE: Would you like an itemized bill to track your monthly usage? You have to pay Rs. 30 extra for it. 

Customer: OK!

CCE: Sir, Would you want to set a personalized caller tone on your phone?

Customer: What is that?

CCE: Whenever someone calls on your mobile phone then he will hear this tone/bhajan/song?

Customer: What are the charges for that?

CCE: Sir Rs. 30 a month only.

Customer: Then I don’t want that.

CCE: Fine Sir. Your services will be activated in 48 hours. Thank you for choosing xyz telecom services.

1. List the steps followed in Selling.

______________________________________________________________________________________________

______________________________________________________________________________________________

2. What is Cross-Selling?

______________________________________________________________________________________________

______________________________________________________________________________________________

3. What is Up-Selling?

______________________________________________________________________________________________

______________________________________________________________________________________________

Exercise
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Key Learning Outcomes
At the end of this module, you will be able to:

1. Understand what is an interview
2. Develop the skills to participate in an interview effectively
3. Know the commonly asked questions in an interview

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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UNIT 12.1: Interview

Unit Objectives
At the end of this unit, you will be able to: 
1. Know what is an interview.

12.1.1 Importance of the Interview

12.1.2 Importance of the Interview

An interview is a meeting which is held between two or more people(i.e. the interviewer(s) and the interviewee, in 
which certain questions are asked by the interviewer in oder to check whether the person who is being interviewed is 
fit for this job role or not.

While appearing for an interview keep in mind the following steps: 

● Greeting – Politely address the interviewer with a smile by saying good morning or good afternoon (whatever is
relevant). Do not forget to have an eye contact with the interviewer while shaking hands.

● Introduction- This refers to the basic introduction which the interviewer or the interviewee gives before commencing
the interview, e.g. name, designation etc.

● Ice-breaker/Small talk- It is the first interaction between the interviewer and the interviewee.

● Questions – It basically refers to the questions which the interviewer asks the interviewee or the questions which
the interviewee asks the interviewer in order to clarify his or her doubts.

● Summary Statement – It refers to summarising the points which an interviewer or interviewee had discussed in an
interview.

● Closing – While closing the interview, the interviewee is required to briefly restate his strengths and link them to
the role being discussed in the interview. Thank each interviewer on the panel individually and request for the
contact information if it’s not known already.

● Thank you and Follow-Up – A thank you corrospondence must be sent through a formal letter or email within 24
hours. The interviewers also follow-up the contacts in order to check the status on hiring decision which is based
on the employer’s timeline as discussed during the interview.

12.1.3 Importance of the Interview
Read the sentences given and mark them as dos or don'ts, in relation to an interview:
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Sentence Dos Don’ts
Be who you are
Burp while talking!
Apply too much make up

Be on time for an interview
You must bump in the cabin or office
Do not greet or respond to the receptionist
Think twice before you speak
Do not visit the company's website before appearing for an 
interview
Dress professionally on the day of an interview
Always argue or contradict to what the interviewer says
Chew the chew gum during the interview
Keep your documents in a proper file
Thank the interviewer
Have the ‘they need me’ attitude
Maintain eye contact and good body language
Do not forget to carry a copy of your resume
Give concise and to the point answers
Do not summarize the interview
Ask questions related to your salary

Table 12.1 Sample of dos and don'ts of interview

1. Have you ever faced an interview? What happened? What according to you happens in an interview?

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

___________________________________________________________________________________________

Exercise
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12.2.1 Questions in an Interview
Now that we are well aware about how to face an interview, let us discuss about the questions which might be asked 
in an interview.

1. Give an introduction about yourself.

It is usually the first question which an interviewer asks as this helps in setting the pace of an interview.

You can answer this question  by explaining something about education qualification, family background, experience, 
hobbies etc.

Try to wind up your answer in two minutes.

Sample Answer:

My name is ABC. I live in New Delhi. I have completed my twelfth from LMN school. My father is a businessman and 
mother is a house-wife. I have a work experience of 1 year with DEF Company Ltd. I am basically fond of reading.

2. Describe yourself as a person?

This question is asked in order to check whether you comprise those qualities which the employers are looking for, so 
answer this question very wisely.

UNIT 12.2: Questions in an Interview

Unit Objectives
At the end of this unit, you will be able to: 
1. Understand the importance of effectively answering questions during the interview process

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
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Sample Answer 1:

I am person who adapts to changes and is passionate enough to learn new things.
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3. Where do image yourself three years from now?

The main reason behind asking this question is to check if you are ambitious enough.

Sample Answer 1:

Three years from now I see myself as a very responsible person who is indispensable and helps in the growth of the 
company.

4. Tell us about some of your greatest strengths.

The trick to answer such questions is by analyzing the requirements of the position you have applied for and

list down some of the qualities a person working in that profile must have.

For example, some of the qualities of people applying for jobs in Retail and BPO industry are: Patience, fluency in 
English, good listening skills, positive attitude etc.

Sample Answer:

My biggest strength is the way I communicate with people. I am able to tackle each and every situation with positive 
attitude.

Some of the strengths you may possess: 

● Hard worker

● Punctual

● Determined

● Able to prioritize

● I have the ability to cope with failures and try to learn from my mistakes.

● Commitment to my work

● Love to learn new things

● I am a team player and work well with others

5. What are your weaknesses?

Each and every person has some or the other weakness. Nobody is born perfect. The most important thing is to 
identify them and work on it.

Sample Answer: 

I am a very emotional person and take things to heart, but I working on it.
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6. Will you be comfortable with working in shifts? Do you have any health problems?

Working for a BPO mostly means you will be working for clients outside the country with a different time zone which 
will require you to work in shifts many times and you have to be prepared for this. If you have any health problems 
which might cause problem while working in shifts, be clear.

7. What can you say about your communication skills?

Communication skills are one of the most important part of all the job role. So every organisation expects the employee 
to be good with their communication skills.

Sample Answer:

My communication skills are decent, and look for opportunities that help me in improving my communication skills.

8. Will you be able to speak for two minutes on a topic?

The interviewer will check your communication skills by asking you to speak on any topic provided by them for two 
minutes.

Topics may include: 

a) Current Issues

b) Hobbies

c) Most memorable day in life

d) Favourite movie

e) How did you spend your last weekend?

f) My training experiences

9. If given an opportunity, how long will you work with our company?

This question asked to see if you are stable and responsible enough.

You must answer such questions by saying that i intend to stay till the point I learn the work and grow at my 
workplace.       

Sample Answer:

If given a chance, I would work for a longer period of time with this company so that I am able to grow career wise. 
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Sample Answer:

Given an opportunity, I see this company as a long term career prospect and time and build my career here.

10. Why should we hire you?

Prepare yourself well in advance to answer this question. Read the job requirements before coming for an interview 
and link your answer to it. This would serve as a reason for you to be hired.

Sample Answer:

Yes, I can work under pressure. There are certain responsibilities which is expected to be performed by employees 
in every job and I am well prepared for that.

11. Will you be able to work under pressure?

Pressure is something which every person learns to handle with time. One cannot avoid working under pressure at 
workplace. Therefore answer to such questions must be yes.

12. Are you comfortable with learning new technologies?

Since we live in a tech savvy world, the answer to this question has to be yes. as technology is something which keeps 
on changing and one has to learn to adapt to changes.

Sample Answer:
Yes, I am comfortable in learning about new technologies as it will help me in performing my task in a better way and 
will be a plus point for me.

Questions and Answers
Make pairs. In each pair, one person will act as an interviewee and another the interviewer. Both have to present the 
whole process of the interview in front of the group.
Think of the answers to the questions above and answer the following questions:
1. Tell us something about yourself.

____________________________________________________________________________________________

____________________________________________________________________________________________

Practical
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2. Where do you see yourself 3 years from now?
____________________________________________________________________________________________

____________________________________________________________________________________________

3. What is your greatest strength?
____________________________________________________________________________________________

____________________________________________________________________________________________

4. What are your weaknesses?
____________________________________________________________________________________________

____________________________________________________________________________________________

5. Will you be comfortable with working in shifts? Do you have any health problems?
____________________________________________________________________________________________

____________________________________________________________________________________________

6. How do you rate your communication skills?
____________________________________________________________________________________________

____________________________________________________________________________________________

7. How do you rate your listening skills?
____________________________________________________________________________________________

____________________________________________________________________________________________

8. Do you consider yourself as a team player?
____________________________________________________________________________________________

____________________________________________________________________________________________

9. How long do you expect to work for us if given an opportunity?
____________________________________________________________________________________________

____________________________________________________________________________________________

10. Why should we hire you?
____________________________________________________________________________________________

____________________________________________________________________________________________

11. Do you think you can work under pressure?
____________________________________________________________________________________________

____________________________________________________________________________________________

12. Are you comfortable in learning new technologies?
____________________________________________________________________________________________

____________________________________________________________________________________________

13. How do you handle pressure? Do you like or dislike these situations?
____________________________________________________________________________________________

____________________________________________________________________________________________
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